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OBJECTIVE
This procedure provides the user a guideline for the routine operation of the Dionex HPLC instrument

in order to enable a successful HPLC analysis.

SCOPE
This procedure applies to all HPLC determinations using the Dionex HPLC instrument. This SOP is
for guidance purposes only and the instrument manual must be consulted for additional information

on the use of this instrument.

DEFINITIONS
Not Applicable.

RELATED PROCEDURES
Not Applicable.

RESPONSIBILITIES
The user is responsible for the carrying out the activities described in this document. Any problems or

unusual errors encountered should be addressed by an experienced user of this instrument.

INSTRUCTIONS

6.1 Instrument Description
The Dionex HPLC system consists of SOR-100A-6 solvent rack, P680 A DGP-6 high-precision
gradient pump, ASI-100 automated sample injector, TCC-100 thermostatted column
compartment, UVD 170U UV-Vis diode array detector and Chromeleon 6.70 chromatography

management software.

6.1.1. Solvent Rack
The solvent rack which is mounted on top of the HPLC system includes a reservoir tray,
solvent reservoirs and appropriate tubing. It contains vacuum degasser for degassing

solvents via the gas-permeable special polymer membranes.
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Figure 1. Solvent Rack front panel.

Table 1. Solvent rack front panel description.

No. Front Panel LEDs Description

1 Power The LED is blue when the Solvent Rack power is on.

2 Vacuum The LED is green if the degasser is working properly.
The LED is red if the degasser vacuum is insufficient for proper
degassing. In this case, the Status LED is also red.
3 Status The LED is green if the degasser and the leak sensors are working
properly.
The LED is red if the leak sensor detected a leak.
The LED is red if the degasser vacuum is insufficient for proper
degassing. In this case, the Vacuum LED is also red.

6.1.2. P680 HPLC Pump
The dual low-pressure gradient pump can be operated with flow rates from 1 uL/min to 10
mL/min and with operating pressures of up to 50 MPa (500 bar). The user can create
programs for gradients and flow parameters, etc. via stand-alone operation or by the
Chromeleon Chromatography Management System. There are six solvent channels, three
channels (A, B and C) each for the left and right pump. The left pump is used for routine
operations. Normally, the solvent channel A is used for water or aqueous solution, channel B

for acetonitrile and channel C for methanol or other organic solvents.
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Figure 2. P680 HPLC pump front panel display.

Table 2. P680 HPLC pump front panel display and controls.

No. Front Panel Element | Description
1 LCD Displays the current pressure, the menus, the programs, and the
individual program steps.
2 Cursor keys; move the cursor to the desired position on the LCD. When
AV P> the State menu is displayed, use the left or right cursor keys to display
the state information for the respective pump or to toggle between the
user interface for the left and for the right pump.
3 Controls on the center keypad:
0...9 Allows direct input of numerical values;
Allows direct submenu selection.
A..Z Allow direct input of the corresponding letters
Decimal point
- Minus sign
Ins Inserts a new program or new program step.
A Arrow key; allows changing the settings;
Increments numerical values;
Pages forward through the commands that are available for selection.
v Arrow key; allows changing the settings;
Decrements numerical values;
Pages backward through the commands that are available for selection.
Del Deletes the selected program or the selected program step.
Esc Returns you to the superior menu on the LCD.
Clears error messages.
— Deletes the character at the cursor position.
-1 (Enter) Confirms the input.
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Continuation of Table 2.

No. Front Panel Element | Description

4 Function keys for direct control:

A,B,C,D The LCD shows the State menu. The cursor appears at the input position
for the %A to %D portions of the solvent (the corresponding LED lights).
Pressing the button for approximately 2 seconds sets the corresponding
portion to 100%.
Notes: The State menu is opened for the pump selected last on this menu.
The %D portion is not available.

Self-test Corresponds to a reset; checks the drives, the sensors, and internal
functions. The self-test is performed immediately.

Flow on/off Turns the flow on (the On LED is lighting) or off (the Off LED is
flashing). The Flow display shows the flow rate.
Note: Go to the State menu first and select the pump for which you want
to turn the flow on or off.

Limits The LCD shows the State menu. The cursor appears at the input position
for the upper pressure limit and the lower pressure limit, respectively.

Set Flow The LCD shows the State menu. The cursor appears at the input position
for setting the flow rate. Enter the desired value and press - (Enter) or
Set Flow to confirm your input.

Start/Stop Start starts the program selected in the Programs menu;
Stop stops the running program

Purge Turns the Purge function on and off.

LEDs:

5 Remote The LED lights when Chromeleon controls the pump.

6 Max./min. The max. LED lights when the pump is shut off because the pressure
exceeds the upper pressure limit. The min. LED lights when the pump is
shut-off because the pressure falls below the lower pressure limit.

7 On/ On lights when the flow is turned on.

Off Off flashes when the flow is turned off

8 3 LEDs The green center LED lights when a drop is recognized on the sensor of
the active rear-seal wash system

Other displays

9 Flow Indicates the current flow rate.

10 Pressure Indicates the current pressure.

6.1.3.

Automated Sample Injector

The autosampler is equipped with a 100-uL syringe, a needle that is part of the sample

loop and sample vial carrier. It has an automatic vial recognition system which is ideal

for unattended operations.
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Figure 3
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Table 3. ASI-100 Automated sample injector front panel display and controls.

No. Front Panel Element | Description
1 LCD Indicates the status, the individual menus, the programs, and the
individual program steps.
2 AV <> The cursor keys move the cursor to the desired position on the LCD.
3 Control Elements in the Center Keypad:
0...9 Allow direct input of numerical values.
R,G,B Define the segment for specifying the sample position.
A,B,C,D Define the row within the segment for specifying the sample position.
Decimal point; toggles between capital and small letters in case of texts.
- Minus sign; toggles between capital and small letters in case of texts.
Ins Re-inserts the line deleted by pressing the Del key above the cursor
position; inserts a new line above the cursor position if no line was
deleted before; proceeds to the next input position when used in text
mode.
A Arrow key; increments numerical values; brings you to the next letter in
the alphabet in case of texts
Arrow key; decrements numerical values; returns you to the previous
v letter in the alphabet in case of texts
Deletes lines in programs and methods; backspace key when the cursor is
Del located at the end of the entry field; deletes the character at the cursor
position.
Esc Returns you to the superior menu on the LCD.
Text Enables. the. text mode allowing you to enter program names and method
names; is displayed at the cursor position.
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Continuation of Table 3

- (Enter) Confirms the input.
4 Function Keys for Direct Control:
Start starts the analysis of the batch/method selected when autosampler is
Start/Sto not busy (the Start/Stop LED is not lighted)
p Stop opens the Stop Menu when the autosampler is busy (the Start/Stop
LED is lighted).
Hold stops the current sample and its analysis time immediately. Also
Hold/Cont. . .
pressed when a command is to be continued after a stop.
Pause interrupts the sequence after the running sample,
Pause/Cont. Cont. continues the sequence with the next sample.
Quick SMP Analyzes a quick sample after the running sample
Wash Performs a wash cycle
Resets and checks drivers, opto sensors, segment detection, MSV
Self Test
movements, etc.
Temp. (ASI-100T/ Displays the set point temperature and the actual temperature on the LCD.
ASI-100PT)
Pressing one of these keys moves the corresponding colored segment to the
R/G/B
front.
LED-Displays:
The cool LED is lighted while the set point temperature is below the actual
temperature;
cool/heat - . . .
The heat LED is lighted while the set point temperature is above the actual
5 (ASI-100T/
ASI-100PT) temperature. . . L
Both LEDs is lighted while the set point temperature is identical to the
actual temperature. They are not lighted if cooling is turned off.
Reports the status of the motorized switching valve:
6 Load/Inject The Load LED is lighted while the syringe is loaded;
The Inject LED is lighted while the sample is injected.
Together they specify the sample position:
The segment that holds the current sample is identified by the lighting LED.
7+8 3 LEDs + Sample The Sample display shows the position of the current sample within the
segment, e.g., b03. The letter (A, b, C, or d) indicates the row while the two
digits indicate the position of the sample within the row.
9 Time Reports the retention time for the current sample.

6.1

4. Thermostatted Column Compartment

The column compartment can hold up to three columns of different lengths. The column

chamber is heated or cooled via the thermoelectric (Pelteir) elements. The temperature can

be set using the front panel controls or via the Chromeleon Data Management system. The

lower temperature limit is +5°C and maximum temperature is +85°C.




@

UNIVERSITAT DE BARCELONA

B

Facultat de Quimica

Standard Operating Procedure (SOP)

Departament de Quimica Analitica.

SOP/CECEM/EQP/01/01 Page 8 of 19

)

Figure 4. TC-100 Column compartment front panel display.

Table 4. TC-100 Column compartment front panel display and controls.

No. Front Panel Element | Function
1 ™ Switches the instrument to stand-by mode.
2 + Increases the set point temperature in increments of 0.1°C
Sets the leak detection mode
3 - Decreases the set point temperature in increments of 0.1°C
Sets the leak detection mode
4 Temperature Indicates the current temperature, the temperature set point, or the leak
detection mode.
Press the Plus or Minus key to display the temperature set point.
Simultaneously press the Plus and Minus keys to display the leak
detection mode.
5 LEDs:
Heating Lighted when the column compartment is heating.
Cooling Lighted when the column compartment is cooling.
Remote Lighted when the column compartment is controlled by Chromeleon.

6.1.5. UV-Vis Diode Array Detector

The diode array detector is equipped with a deuterium lamp, an analytical flow cell and

powerful optics which enable simultaneous detection at four wavelengths and recording of

three-dimensional data. The flow cell has a cell volume of 10 pL, a path length of 9 mm

and a maximum pressure limit of 10 MPa (100 bar).
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LED - = ‘

\‘
Figure 5. UVD 170U detector front panel.

Table 4. Detector LED description.

LED Status

A red light is flashing. The detector is not yet connected to Chromeleon.

A red light is burning. The detector is connected to Chromeleon (firmware started).
A green light is flashing. Deuterium lamp is preheating.

A green light is burning. Deuterium lamp is on.

6.2. PROCEDURE
6.2.1. Preliminaries

6.2.1.1. Prepare the required mobile phase and transfer to the designated solvent reservoirs.
Use the solvent channels for the left pump.

6.2.1.2. Ensure that the solvent reservoirs are filled enough for the whole day operation. The
solvent line sinkers must be immersed in each solvent reservoir and cover the solvent
reservoirs to minimize atmospheric contamination and evaporation.

6.2.1.3. Check if the column or waste outlets are drained into the waste containers. Empty the
waste container if necessary.

6.2.1.4. Prepare the samples and standards in vials and place them in the autosampler rack.

6.2.1.5. Ensure that the liquid reservoir of the rear-seal wash system is always filled between
the min. and max. marks on the label. Replace the liquid (methanol) at regular
intervals. When using solvents with high salt content, replace the liquid at least once a

week. Fill the liquid reservoir or change the washing liquid as follows.
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6.2.1.5.1. Hold the liquid reservoir including the holding clip and push both parts
together vertically toward the top (See Figure 6).

6.2.1.5.2. While holding the reservoir by its cap (detector), unscrew the reservoir
including the holding clip from the cap.

6.2.1.5.3. Replace/refill the liquid in the reservoir until the level is between the min. and
max. marks.

6.2.1.5.4. Reconnect the liquid reservoir.

6.2.1.6. Fill out the instrument logbook.

detector

Pulling direction
for removing the
reservoir

Figure 6. Removing the liquid reservoir of the rear-seal wash system.

6.2.2. System startup
6.2.2.1. Turn ON all the instrument modules (pumps, autosampler, column heater and
detector).
6.2.2.2. Purge the solvent line as follows:
6.2.2.1.1. Wait for the pump to finish self-check test. After the pump passes the self-
test, the Main menu is displayed on the LCD screen.
6.2.2.1.2.  Use the up/down cursor keys to select the desired option on the Main menu.
Choose State and press the . (Enter) key.
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6.2.2.1.3.

6.2.2.1.4.

6.2.2.1.5.

6.2.2.1.6.
6.2.2.1.7.

6.2.2.1.8.

While in the State menu, use the left/right cursor keys to toggle between the
left and right pump. Choose the left pump by pressing the left cursor key.
The LCD display should show FI: L.

Set the channel to be purged to 100%. For example, set channel A to 100%.
Use the up/down cursor key on the keypad to move the cursor to the %A
field. Using the keypad, type 100 and press the Enter (.1 ) key.

Place a beaker at the end of the column inlet tubing (valve position 2) to
collect the eluent.

Press the Purge key.

Wait for a few minutes until a steady pressure is reached. Check if there are
no air bubbles (there must be a continuous stream of solvent coming out).
The instrument has a default purge time of 1.5 minutes. After this time, the
instrument automatically stops purging. Press the Purge key again to stop the
purging if necessary.

Repeat the same procedure for all the channels to be purged.

6.2.2.3. Connect the HPLC column. The column inlet tubing is in valve position 2 while the

column outlet tubing is in valve position 6. Close the column compartment after the

column has been installed.

6.2.2.4. Turn ON the computer connected to Dionex HPLC (password is cecem).

6.2.2.5. Double-click on the Chromeleon icon found at the desktop to open the Chromeleon

software. The active window would normally default to the Browser window which

was last opened by the previous user. (See Figure 7)

6.2.2.6. Start the server monitor program to control the entire chromatography system via the

computer. Right click on the Chromeleon icon which appears on the Windows task

bar (close to the Windows system clock) and choose Start Server. In the instrument,

the LED lights corresponding to Remote should light up.
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Figure 7. Chromeleon browser window.
6.2.2.7. Create a directory with your own file name, if necessary. From the Browser window
toolbar select File > New Directory. Create also a subdirectory and name the file
according to the following format: YYMMDD, where YY stands for the year, MM for
the month and DD for the day.
6.2.2.8. Open the default Control Panel. From the Browser window, open Dionex Templates

> Panels directory and select the control panel that corresponds to your system.
Double-click to open the panel. Alternatively, you can copy one of the mostly used
control panel from the existing directories. Open one of the folders in CECEM-
8261J2B95B loca\CECEM-DIONEX, copy the files paneél.autosampler.pan and
summit_x2_on-line_sample préparation.pan and paste in your folder. Double-lick on
summit_x2_on-line_sample preparation.pan to open the control panel. The control
panel window shown in Figure 8 is displayed. Toggle between the Browser and the

Control Panel window by pressing CTRL + TAB.
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Figure 8. Control panel window.

6.2.2.9. Set-up the initial parameters required for column conditioning (or for the

chromatographic run) such as the mobile phase composition, flow rate and column
temperature (if necessary). In the Control Panel window:

6.2.2.9.1. Click on Settings under Pump System to set the pump parameters. In the Left

Pump field, check on the box for Motor on. Likewise, check the box for

connect in the Status field. Enter the values for the flow rate and the % solvent

composition and press Enter. Start from a low flow rate and increase the flow

gradually (0.1 mL/min steps) until the desired flow setting. Make sure that
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under the RightPump field the flow is set to 0 mL/min. Click Close to go back

to the main control panel window.

6.2.2.9.2. Click on Settings under Column Qven to set the required column temperature.

In the Status field, check the box for connect. Enter the desired value for

temperature in the Temperature box. Make sure that the MSV Position is set

to A. Click Close to go back to the main control panel window.
6.2.2.9.3. Click on Settings under Photodiode Array Detector to turn On the UV lamp.
Make sure that the Status is connected. Check on the UV lamp on check box

to turn on the lamp. Wait for the UV lamp to finish its calibration before

starting the sequence. Click Close to go back to the main control panel

window.

6.2.2.10. Create a sequence for the analysis. If an existing sequence can be used, save the

sequence under a new file name. To create a new sequence:

6.2.2.10.1.
6.2.2.10.2.

6.2.2.10.3.

6.2.2.10.4.

On the File menu of the browser window, click New.
From the list, select Sequence (using Wizard). Click OK to start the
Sequence Wizard. The Chromeleon Sequence Wizard: Welcome window
appears. Click Siguiente to continue.
In the Choose a Timebase window, make sure that the default settings
appear:

Timebase: CECEM-DIONEX

Computer. CECEM-82612B95B

Protocol: My computer
Click Siguiente.
Create all unknown samples and standards to be processed in the Unknown
Samples and Standard Samples window. Select Use Template. Enter
sample/standard name, number of injections per vial, position of the first
sample, injection volume, and click Apply to display the result of your input

in the sample list (Sequence Preview). You can edit the sample/standard list
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6.2.2.10.5.

6.2.2.10.6.

6.2.2.10.7.

6.2.2.10.8.
6.2.2.10.9.

information in the Browser window after closing the Sequence Wizard. Click
Siguiente to proceed to the next step.

Alternatively, you can create sample/standard list in the Browser window,
hence, you can proceed to the next step without making a sample list. In case
the sample list will be created in the Browser window, follow the steps
outlined in Section 6.2.2.10.7.

In the Methods and Reporting window, enter the information for the
program file, quantification method, preferred report and preferred channel.
If you do not have an existing method file, you can leave these fields empty
for now. Click Siguiente.

In the Saving the Sequence window, enter the desired sequence name, title
and location. The default Datasource is CECEM-82612B95B local. Click
Browse to select the directory on which you will save your data. Click
Finalizar to save the sequence. The sequence is now displayed in the
Browser. A default quantification method (défault.qnt) and default program
(/PIs UV pruebas iniciales gradient 1.pgm) appear in the browser window.
To create a sample/standard list directly from the browser window, click on
the Name field, type the name of the sample/standard. Define the other
parameters such as Type (unknown, standard, validate, blank, matrix, spiked
or unspiked), P0s. (position of the vial in the autosampler rack), Inj. Vol. (in
uL), Program (select from the saved program files or create a new one by
following the instructions in Section 6.2.2.11), Method (select the default
setting) and Status (select Single).

Click on the Save icon to save the sequence.

To add new sample in the sequence, highlight the end row of the sequence or
place the cursor in the last line and press the arrow down key on the

keyboard.

6.2.2.10.10. To edit sample information in the sequence, just click on the particular

sample field and enter the new information directly via the keyboard. Click

on the Save icon to save the changes.
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6.2.2.11. Create a p
6.2.2.11.1.
6.2.2.11.2.

6.2.2.11.3.

6.2.2.11.4.

6.2.2.11.5.

rogram file if you do not have an existing program.
In the Browser window, select New on the File menu.
Select Program File from the list and click OK. The Program
Wizard: Wizard Options window appears. Choose Regular
Program and click Siguiente to continue.
In the Choose a Timebase window, make sure that the default
settings appear:

Timebase. CECEM-DIONEX

Computer: CECEM-82612B95B

Protocol: My computer
Click Siguiente.
In the Column Oven Options, check on Use temperature control
check box if column temperature oven is required and enter the
desired temperature. In the Leak Detection dialog box, select
Standard. Under Column MSV Position, select A. Click Siguiente
to continue.
In the PumpLeft Options, select from isocratic or gradient operation

of the pump.

6.2.2.11.5.1. For an isocratic run, enter the solvent composition in the

Start field. Enter the flow rate in the Start field under the
Column Flow.

6.2.2.11.5.2. For Multi-step gradient options, enter the retention time,

flow rate and solvent composition. A default setting of 5 for
the curve corresponds to a linear gradient. To append new
lines to the table, place the cursor in the last line of the table

and press the arrow down key on the keyboard.

6.2.2.11.5.3. Enter the desired pump pressure upper limit if it is different

from the default setting of 400 bar.

6.2.2.11.5.4. Click Siguiente to continue.
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6.2.2.11.6. In the PumpRight Options, make sure that the Column Flow is set
to 0 mL/min under the Start field. Click Siguiente to continue.

6.2.2.11.7. In the Sampler Options, enter the desired values if the default
settings will not be used. Check on Synchronize injection with
pump check box and choose Pump Left. Click Siguiente to continue.

6.2.2.11.8. In the Acquisition Options window, specify the acquisition time and
check on the channel/s to be used for acquiring the signals. Check on
PumpLeft Pressure and UV check boxes. Click Siguiente to
continue.

6.2.2.11.9. In the PumpLeft_Pressure Options, select Auto for Step and check
on the Average check box.

6.2.2.11.10. In the UV Options window, specify the desired settings and
parameters to be recorded during sample processing. Click Siguiente
to continue.

6.2.2.11.11. In the Relay and State Devices Options window, just click
Siguiente to continue.

6.2.2.11.12. In the Completion window, enter a description for your program
and select Save the program immediately. Click Finalizar to
complete the Program Wizard and save the program file. The Save As
window appears. Enter the program name and click Save to finish.
The program name is now displayed in the Browser window. To
review the Program File, double-click on the program name. The
Program file Window appears. You can edit the program file
parameters in this window. Click on Save to save the changes. Close

the window to go back to the Browser window.

6.2.3. Sample Analysis
6.2.3.1. After the initial condition for the chromatographic run is attained and the

column and the system have equilibrated, start the analysis.
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6.2.3.2. Run the sequence. In the Browser window, highlight the row/s corresponding
to sample/s to be run and click on the Start/Stop icon from the toolbar. Select
Ready Check and click OK if all the ready check information is acceptable.
Click Start to begin the analysis. Go to the control panel to see the status of
the current HPLC run. When the run is finished for a given sample, the
instrument will automatically run the next sample in the sequence.

6.2.3.3. To view the chromatogram, go to the Browser window and double-click on

the sample name.

6.2.4. System Shutdown
6.2.4.1. Make sure that all the data acquisition process is finished before turning off
the instrument.
6.2.4.2. Turn off the UV detector.
6.2.4.3. Wash the syringe and needle with methanol or a suitable solvent after the
analysis. To perform the washing procedure, proceed as follows.
6.2.4.3.1. Fill a 1-mL glass vial with the washing solvent and place in position
B99 of the autosampler rack.
6.2.4.3.2.  While in the Browser window, open your folder and double click on
the file panel autosampler.pan to open the control panel for the
autosampler. The autosampler control panel appears. Make sure that
the Status displays connected and Ready.
6.2.4.3.3. Click on Wash Settings. The Wash Procedure dialog box appears.
In the Wash Procedure dialog box, the default setting for the Wash
Vial is B99. Change the setting of the Wash volume to 100 pL. It is
not necessary to change the default settings for the other parameters.
6.2.434. Click on Wash. The autosampler then performs the washing
procedure.
6.2.4.3.5. Perform additional washings of the syringe.
6.2.4.3.6. Close the Wash Procedure dialog box and the autosampler control

panel window to go back to the browser window.
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6.2.44.

6.24.5.

6.2.4.6.
6.2.4.7.
6.2.4.8.

Replace the buffered mobile phase with water and flush the column to remove
the buffer. Use a wash volume equivalent to 10 times the column volume at an
operational flow rate (for example, 0.30 mL/min). Change the mobile phase
composition gradually to pure acetonitrile or to a solvent required for storing
the column. Flush the column with the storage solvent using a wash volume
equivalent to 10 times the column volume.

If necessary, turn off the column oven first and let the column cool down
before turning off the pump flow.

Turn off the other instrument modules.

Disconnect the column.

Turn off the computer.

6.2.5. Observations

In case of power failure, switch off the instrument modules. Once the power is

restored, turn on the instrument modules and the computer. The previous functions

and programs are no longer executed. But if the HPLC system is operated under

Chromeleon, the system can be programmed to start again with the desired

operation after a power failure. The instrument performs again the self-test, wait

until the self-test is finished before resuming with work.
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3. 0BJECTIVE
Performance verification of an HPLC instrument is necessary to provide evidence that the entire
HPLC system is working correctly and there is an assurance on the reliability of the HPLC data.
Verification is usually done by examining the performance attributes of the different HPLC modules.
This document describes the activities which are carried out during the performance verification of

the HPLC instrument.

4. SCOPE
This procedure only applies to the Dionex HPLC system. Performance verification includes
determination of pump flow rate accuracy, pump flow rate precision, pump gradient accuracy,
injection precision, injection volume linearity, injection carryover, column oven accuracy column
oven precision, column oven temperature stability, linearity of detector response and measurement of

the noise and drift.

5. DEFINITIONS

5.1. Accuracy — closeness of agreement between a measured quantity value and a true quantity

value of a measurand.

5.2. Precision — closeness of agreement between indications or measured quantity values obtained

by replicate measurements on the same or similar objects under specified conditions.

5.3. Linearity — the ability (within a given range) to obtain results which are directly proportional to

the concentration (amount) of analyte in the sample.

5.4. Stability — property of a measuring instrument, whereby its metrological properties remain

constant in time

5.5. Noise — random fluctuations occurring in a signal that are inherent in the combination of

instrument and method.
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5.6. Instrumental drift — continuous or incremental change over time in indication, due to changes in

metrological properties of a measuring instrument

6. RELATED PROCEDURES
Standard Operating Procedure for the Dionex HPLC System with UV-Vis Diode Array Detector,
SOP/CECEM/EQP/01/01

Standard Operating Procedure for the Testo 945 digital thermometer with thermocouple, PNT
2090143 APR/017 Ediccio Num.1

7. RESPONSIBILITIES

The user of the instrument is responsible for the verification of the performance of the HPLC

instrument.

8. INSTRUCTIONS
8.1. Equipment and Materials

Dionex Summit HPLC system composed of:

SOR-100A-6 solvent rack

P680 A DGP-6 high-precision gradient pump
ASI-100 automated sample injector
TCC-100 thermostatted column compartment
UVD 170U UV-Vis diode array detector

Chromeleon 6.70 chromatography management software

LiChrospher 100 RP-18 (Spum) HPLC cartridge, 125mm x 4mm (Agilent or equivalent)

Analytical balance (Mettler Toledo AT261 Delta Range or equivalent)

10 mL volumetric flask (Afora or equivalent)

Timer/stopwatch

Calibrated digital thermometer with thermal probe (Testo 945 or equivalent)
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8.2. Reagents and Standards

8.2.1. Solvents and standard
Water, LC-MS grade (Fluka Sig,ma Aldrich or equivalent)
Methanol, LC-MS grade (Fluka Sigma Aldrich or equivalent)
Acetonitrile, LC-MS grade (Fluka Sigma Aldrich or equivalent)

Acetone, GC grade (Fluka Sigma Aldrich or equivalent)

Caffeine, analytical grade (Merck or equivalent)

8.2.2. Preparation of Solutions

8.2.2.1.

8.2.2.2.

8.2.2.3.

8.2.24.

8.2.2.5.

8.2.2.6.

8.2.2.7.

Caffeine stock solution (100 ppm). Weigh 10 mg of caffeine standard and dilute to 10
mL with LC-MS grade water. Determine the weight of the solution.

Caffeine standard solution (300 ppm). Take 300 pL of 1000 ppm caffeine stock solution
and weigh in a 1 mL clear vial. Add 700 pL of LC-MS grade water and weigh the
resulting solution.

Caffeine standard solution (220 ppm). Take 220 pL of 1000 ppm caffeine stock solution
and weigh in a 1 mL clear vial. Add 780 pL of LC-MS grade water and weigh the
resulting solution.

Caffeine standard solution (140 ppm). Take 140 uL of 1000 ppm caffeine stock solution
and weigh in a 1 mL clear vial. Add 860 puL. of LC-MS grade water and weigh the
resulting solution.

Caffeine standard solution (75 ppm). Take 75 uL of 1000 ppm caffeine stock solution
and weigh in a 1 mL clear vial. Add 925 pL of LC-MS grade water and weigh the
resulting solution.

Caffeine standard solution (60 ppm). Take 60 uL of 1000 ppm caffeine stock solution
and weigh in a 1 mL clear vial. Add 940 uL of LC-MS grade water and weigh the
resulting solution.

Caffeine standard solution (40 ppm). Take 40 uL of 1000 ppm caffeine stock solution
and weigh in a 1 mL clear vial. Add 960 pL of LC-MS grade water and weigh the

resulting solution.
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8.2.2.8.

8.2.2.9.

8.2.2.10.
8.2.2.11.

Caffeine standard solution (10 ppm). Take 250 pL of 40 ppm caffeine standard solution
and weigh in a 1 mL clear vial. Add 750 pL. of LC-MS grade water and weigh the

resulting solution.

Caffeine standard solution (5 ppm). Take 125 pL of 40 ppm caffeine standard solution
and weigh in a 1 mL clear vial. Add 875 pL of LC-MS grade water and weigh the

resulting solution.

99.5:0.5 (v/v) Methanol:acetone. Add 1 mL of acetone to 199 mL of methanol and mix.

85:15 (v/v) Water:acetonitrile. Transfer 850 pL of water in a 1 mL clear vial. Add 150

pL of acetonitrile and mix.

8.3. PROCEDURE

Performance verification is performed once or twice a year or whenever a component has been

repaired and the component may affect the reliability of the instrument performance. However,

whenever a part of the module has been changed or repaired, it is not necessary to perform all the

activities indicated herein. Normally, only the affected module needs to be tested. Table 1 lists the

different parameters to be tested and the acceptance limits.

Table 1. Performance verification of the HPLC instrument.

Module Performance Acceptance Criteria Frequency
Attributes
Pump Flow rate accuracy +29% of the set flow rate 6 months
Flow rate precision < 1% RSD 6 months
Gradient accuracy +1% of the step gradient composition 6 months
Injector | Injection precision <1% RSD 6 months
Injection volume r>0.999 12 months
linearity %RSD (peak area/injection volume ratio) <5%
Injection carryover <1.5% 6 months
Column | Thermostatting +3°C maximum deviation from the set| 6 months
oven accuracy temperature
Thermostatting +0.5°C maximum difference 6 months
precision
Temperature stability | +1°C maximum difference 6 months
Detector | Linearity of detector | r > 0.999 12 months
response %RSD (peak area/concentration ratio) <5%
Noise and drift Noise: 0.200 mAU 12 months
Drift: 0.800 mAU/h
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8.3.1. Preliminaries
8.3.1.1. Prepare the required mobile phase/s.
8.3.1.2. Prepare the caffeine standard solutions.
8.3.1.3.  Turn on all the HPLC modules.
8.3.1.4. Fill the respective solvent reservoirs with appropriate solvents.
8.3.1.5. Prime the pump by following the instructions on the instrument operation manual.
8.3.1.6. Turn on the computer and open the Chromeleon program. Create a directory where to
save the data. Create a sequence and name the sequence as Performance Verification.
8.3.1.7. Set the column oven temperature to 25°C except when performing verification of the

column oven.

8.3.2. Performance verification of the pump
8.3.2.1. Determination of flow rate accuracy
8.3.2.1.1.  Fill solvent channel A of the left pump with water.
8.3.2.1.2. Connect the HPLC column.
8.3.2.1.3. Set the flow rate to 1 mL/min.
8.3.2.1.4. Allow the system and the pressure to equilibrate for at least 15 minutes.
8.3.2.1.5. Using a 10 mL flask, collect the eluent at the end of the detector and measure the
time it takes to fill the flask.
8.3.2.1.6. Perform an additional 2 replicates.
8.3.2.1.7. Calculate the flow rate (mL/min).

volume of flask (mL)
time to fill (min)

Flow rate (mL/min) =

8.3.2.1.8. Determine the average flow rate.
8.3.2.1.9. Compare the average flow rate with the set flow rate.

8.3.2.1.10. Complete the report form (page 2) in Annex 1 of this document.

8322 Determination of flow rate precision
Note: This procedure is also performed to verify the injection volume precision.

8.3.2.2.1.  Fill solvent channel A of the left pump with water.
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8.3.2.2.2.
8.3.2.2.3.
8.3.2.24.
8.3.2.2.5.

8.3.2.2.6.

8.3.2.2.7.

8.3.2.2.8.

8.3.2.2.9.

8.3.2.2.10.
8.3.2.2.11.
8.3.2.2.12.

Fill solvent channel B of the left pump with acetonitrile.
Connect the HPLC column.
Set the flow rate to ImL/min.
Turn on the UV detector and allow the detector and the system to stabilize for at
least 15 minutes.
Place the vial of the 140 ppm caffeine standard solution in the autosampler vial
rack.
Create a program file following the instructions on the instrument operation
manual. In the program file, the following parameters must be specified:
Column oven options: Set the temperature to 25°C
PumpLeft options: Gradient Type: Isocratic
%B Name: acetonitrile; Start: 15%
%C: Start: 0%
Column Flow Start: 1 mL/min
Acquisition Time. From 0 min to 6 min
Acquisition channels/devices: Pump Left Pressure and UV
UV Options.: Wavelength: 272 nm

Save the program as flow precision.

In the Chromeleon Browser window, define the parameters for the standard to be
run.
Type. Unknown
Injection Volume: 5 uL
Program: flow precision
Method. default
Status: Single
Run the standard.
Perform 10 injections of the 140 ppm caffeine standard solution.
Determine the retention time of caffeine in each injection.
Calculate the average retention time, standard deviation and %RSD. The %RSD

indicates the flow rate precision.
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8.3.2.2.13. Complete the report form (page 3) in Annex 1 of this document.

8.3.2.3. Determination of gradient accuracy

8.3.2.3.1.

8.3.2.3.2.

8.3.2.3.3.

8.3.2.3.4.

8.3.2.3.5.

Fill channel A of the left pump with a 99.5:0.5 (v:v) mixture of methanol and

acetone.

Fill channel C of the left pump with methanol.

Set flow rate to 1 mL/min.

Turn on the UV detector and allow the detector and the system to stabilize for at

least 15 minutes.

Create a program file following the instructions on the instrument operation

manual. In the program file, the following parameters must be specified:

Column oven options: Set the temperature to 25°C

PumpLeft options: Gradient Type: Multi-Step Gradient

Curve: 5

Flow rate: 1 mL/min

%B: 0

Table 2. Program for gradient accuracy testing.

Time (min) % C % A
0 100 0
3 100 0

6 0 100

9 0 100
9.2 20 80
12 20 80
12.2 40 60
15 40 60
15.2 60 40
18 60 40
18.2 80 20
21 80 20
21.2 100 0
25 100 0

Acquisition Time: From 0 min to 25 min

Acquisition channels/devices. Pump Left Pressure and UV
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8.3.2.3.6.

8.3.2.3.7.
8.3.2.3.8.

8.3.2.3.8.1.

8.3.2.3.8.2.

8.3.2.3.8.3.

8.3.2.3.9.

UV Options.: Wavelength: 265 nm

Save the program as gradient accuracy.

In the Chromeleon Browser window, define the parameters for the blank sample

to be run.

Type: Blank

Injection Volume: 1 pL
Program: gradient accuracy
Method. default

Status. Single

Perform the blank run.

From chromatogram, measure the absorbance change (expressed as height from

the baseline to the plateau) in each gradient step from 100%C (methanol) to
100%A (99.5:0.5 methanol:acetone) and then back to 100%C. For example,

determine the height corresponding to 20%A, 40%A and so on. These step

heights can be obtained by manually assigning the peaks in the chromatogram

using Chromeleon as follows.

4

Remove the unidentified peaks in the chromatogram. To do this, point
the cursor in the unnecessary peak/s and press Delete. The only identified
peak that is left should correspond to the gradient elution.

To divide the peak into the corresponding steps, point the cursor in the
flat portion of the step, right-click and choose Split peak. Do the same
for the remaining steps.

To adjust the vertical line corresponding to the height of the gradient
step, go to the Integration toolbar and click on the delimiter tool icon.

Click on the vertical line and move the line in the desired position.

Determine the gradient accuracy by calculating the relative heights (expressed as

%Height ratio) of %A to 100%A. Determine the deviation between the calculated

%Height ratio and the set value for %A in the gradient.

Height of %A

%Height ratio =—
Height of 100%A




Facultat de Quimica
@ Standard Operating Procedure (SOP)

UNIVERSITAT DE BARCELONA

@ Departament de Quimica Analitica.

SOP/CECEM/EQP/02/01 | Page 11 of 18

8.3.2.3.10.  Complete the report form found (page 4) in Annex 1 of this document.

8.3.2.3.11. Repeat the determination of the gradient accuracy with the other channels.

8.3.3. Performance verification of the autosampler
8.3.3.1.  Determination of injection volume precision
8.3.3.1.1. Follow the procedure outlined in Section 6.3.2.2, Determination of flow rate
precision.
8.3.3.1.2. Determine the peak area of caffeine in each injection.
8.3.3.1.3. Calculate the average peak area, standard deviation and %RSD. The %RSD
indicates the precision of the injection volume.

8.3.3.1.4. Complete the report form (page 5) in Annex 1 of this document.

8.3.3.2.  Determination of injection volume linearity
8.3.3.2.1. Fill solvent channel A with water.
8.3.3.2.2. Fill solvent channel B with acetonitrile.
8.3.3.2.3. Connect the HPLC column.
8.3.3.2.4. Set the flow rate to 1mL/min.
8.3.3.2.5. Turn on the UV detector and allow the detector and the system to stabilize for at
least 15 minutes.
8.3.3.2.6. Place the vial of the 10 ppm caffeine standard solution in the autosampler vial
rack.
8.3.3.2.7. In the Chromeleon Browser window, define the parameters for the caffeine
standard to be run.
Type. Unknown
Injection Volume: 5 pL
Program: flow precision (See program parameters in Section 6.3.2.2)
Method. default
Status: Single
8.3.3.2.8. Run the standard.
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8.3.3.2.9. Perform additional injections of the 10 ppm caffeine standard using the same
parameters but with different injection volumes: 10, 20, 40 and 80 pL.

8.3.3.2.10. Determine the retention time and the peak area of caffeine in each injection
volume.

8.3.3.2.11. Plot peak area vs. injection volume. Determine the correlation coefficient (r) of
the regression line.

8.3.3.2.12. Calculate the peak area/injection volume ratio at each injection volume.
Determine the %RSD of the peak area/injection volume ratios.

8.3.3.2.13. Complete the report form (page 6) in Annex 1 of this document.

8.3.3.3.  Determination of injection carryover
8.3.3.3.1.  Fill solvent channel A with water.
8.3.3.3.2.  Fill solvent channel B with acetonitrile.
8.3.3.3.3.  Connect the HPLC column.
8.3.3.3.4.  Set the flow rate to 1mL/min.
8.3.3.3.5. Turn on the UV detector and allow the detector and the system to stabilize for at
least 15 minutes.
8.3.3.3.6. Place the vials of 75 ppm caffeine standard solution and 85:15 (v:v)
water:acetonitrile in the autosampler vial rack.
8.3.3.3.7. In the Chromeleon Browser window, define the parameters for the caffeine
standard and blank (85:15 (v:v) water:acetonitrile) to be run.
Type. Unknown
Injection Volume: 5 pL
Program: flow precision (See program parameters in Section 6.3.2.2)
Method: default
Status: Single
In the generated sequence, it is necessary that the injection of the blank
immediately proceeds after the run for the standard is finished.
8.3.3.3.8.  Run the sequence for the standard and blank.

8.3.3.3.9.  Perform this procedure three times.
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8.3.3.3.10. Determine the retention time and peak area of caffeine in the standard and blank
injections.
8.3.3.3.11. Calculate the %carryover. Determine the average.

peak area of caffeine in blank
peak area of caffeine in standard

%Carryover = x100

8.3.3.3.12.  Complete the report form (page 8) in Annex 1 of this document.

8.3.4. Performance verification of the column oven
8.3.4.1. Determination of column oven accuracy

8.3.4.1.1. Fill solvent channel A with water.

8.3.4.1.2. Connect the column inlet and outlet tubings with an LC zero dead volume union.

8.3.4.1.3. Set the flow rate to 0.100 mL/min.

8.3.4.1.4. Place the sensor of the calibrated thermometer inside the oven. Make sure that
the sensor is not touching any heated part of the column oven compartment.

8.3.4.1.5. Set the column temperature to 20°C.

8.3.4.1.6. Allow the system to attain the set temperature as indicated on the front display of
the column compartment.

8.3.4.1.7. Record the actual temperature reading obtained from the digital thermometer.
Record the actual temperature reading every after 3 minutes. Perform 3
temperature readings.

8.3.4.1.8. Repeat the same procedure using a set temperature of 40°C and 60°C.

8.3.4.1.9. If the digital thermometer has an available data of correction factors, incorporate
the corrections in the measured temperature.

8.3.4.1.10. Compare the measured (or corrected) temperature to the set temperature.
Calculate the deviation of the measured (or corrected) temperature to the set
temperature in each temperature reading.

8.3.4.1.11. Complete the report form (page 10) in Annex 1 of this document.

8.3.4.2. Determination of column oven temperature precision
8.3.4.2.1. Fill solvent channel A with water.
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8.3.4.2.2. Connect the column inlet and outlet tubings with an LC zero dead volume union.

8.3.4.2.3. Set the flow rate to 0.100 mL/min.

8.3.4.2.4. Place the sensor of the calibrated thermometer inside the oven. Make sure that
the sensor is not touching any heated part of the column oven compartment.

8.3.4.2.5. Set the column temperature to 40°C.

8.3.4.2.6. Allow the system to attain the set temperature as indicated on the front display of
the column compartment.

8.3.4.2.7. Register the actual temperature reading displayed on the digital thermometer.

8.3.4.2.8. After registering the temperature reading, set the column temperature to 35°C.
After this set temperature is reached, set the temperature again to 40°C.

8.3.4.2.9. After the set temperature of 40°C is reached, record the actual temperature
displayed on the digital thermometer.

8.3.4.2.10. Repeat the procedure once more.

8.3.4.2.11. If the digital thermometer has an available data of correction factors, incorporate
the corrections in the measured temperature.

8.3.4.2.12. Calculate the maximum difference between the 3 temperature readings.

8.3.4.2.13. Complete the report form (page 11) in Annex 1 of this document.

8.3.4.3. Determination of column oven temperature stability

8.3.4.3.1. Fill solvent channel A with water.

8.3.4.3.2. Connect the column inlet and outlet tubings with an LC zero dead volume union.

8.3.4.3.3. Set the flow rate to 0.100 mL/min.

8.3.4.3.4. Place the sensor of the calibrated thermometer inside the oven. Make sure that
the sensor is not touching any heated part of the column oven compartment.

8.3.4.3.5. Set the column temperature to 40°C.

8.3.4.3.6. Allow the system to attain the set temperature as indicated on the front display of
the column compartment.

8.3.4.3.7. Register the actual temperature reading (every after 4 minutes) obtained from the
digital thermometer for a period of 1 hour. This corresponds to 15 temperature

readings.
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8.3.4.3.8. If the digital thermometer has an available data of correction factors, incorporate
the corrections in the measured temperature.
8.3.4.3.9. Plot the measured (or corrected) temperature vs. time.

8.3.4.3.10. Complete the report form (page 12) in Annex 1 of this document.

8.3.5.  Performance verification of the UV detector
8.3.5.1. Determination of the linearity of detector response
8.3.5.1.1.  Fill solvent channel A with water.
8.3.5.1.2.  Fill solvent channel B with acetonitrile.
8.3.5.1.3. Connect the HPLC column.
8.3.5.1.4. Set the flow rate to ImL/min.
8.3.5.1.5.  Turn on the UV detector and allow the detector and the system to stabilize for at
least 15 minutes.
8.3.5.1.6. Place the vials of the 10, 60, 140, 220 and 300 ppm caffeine standard solutions in
the autosampler vial rack.
8.3.5.1.7.  In the Chromeleon Browser window, define the parameters for caffeine standards
to be run.
Type. Unknown
Injection Volume: 5 pL
Program: flow precision (See program parameters in Section 6.3.2.2)
Method.: default
Status: Single
8.3.5.1.8. Run the sequence for the standards.
8.3.5.1.9. Determine the retention time and the peak area of caffeine in each standard.
8.3.5.1.10. Plot peak area vs. concentration. Determine the correlation coefficient (r) of the
regression line.
8.3.5.1.11. Calculate the peak area/concentration ratio at each concentration. Determine the
%RSD of the ratios.
8.3.5.1.12. Complete the report form (page 13) in Annex 1 of this document.
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8.3.5.2. Determination of noise and drift
8.3.5.2.1. Fill solvent channel A with water.
8.3.5.2.2. Fill solvent channel C with methanol.
8.3.5.2.3. Connect the column.
8.3.5.2.4. Set the flow rate to ImL/min.
8.3.5.2.5. Turn on the UV detector and allow the detector and the system to stabilize for at
least 1 hour.
8.3.5.2.6. Create a program file following the instructions on the instrument operation
manual. In the program file, the following parameters must be specified:
Column oven options: Set the temperature to 25°C
PumpLeft options: Gradient Type: Isocratic
%B Start: 0%
%C: Start: 50%
Column Flow Start: 1 mL/min
Acquisition Time. From 0 min to 20 min
Acquisition channels/devices. Pump Left Pressure and UV
UV Options.: Wavelength: 254 nm
Save the program as noise and drift.
8.3.5.2.7. In the Chromeleon Browser window, define the parameters for the blank run.
Type: Blank
Injection Volume: 1 pL
Program: noise and drift
Method.: default
Status: Single
8.3.5.2.8. Perform the blank run.
8.3.5.2.9. View the chromatogram. Use Chromeleon to calculate for the noise and drift.
The noise corresponds to the distance between two parallel lines through the
measured minimum and maximum values and the regression line. The drift is

estimated as the slope of the regression line.
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8.3.5.2.10. Divide the

chromatographic baseline into 20 segments (1 minute interval in each

segment) and determine the noise and drift in each segment.

8.3.5.2.11. The drift is

8.3.5.2.11.1.

8.3.5.2.11.2.

8.3.5.2.11.3.

8.3.5.2.11.4.

8.3.5.2.11.5.

8.3.5.2.11.6.
8.3.5.2.11.7.

8.3.5.2.12. The noise

8.3.5.2.12.1.

8.3.5.2.12.2.

8.3.5.2.12.3.

8.3.5.2.12.4.

determined as follows.

While viewing the chromatogram in the Integration View, right-click
on the Table Menu and select Add Column. The Add Report
Column dialog box appears.

Mark Chromatogram from the Categories list and select Signal
Value from the Variables list.

Click Parameter to open the Parameter Input for "Signal value”
dialog box.

Select Drift and Restrict Range check boxes and enter the desired
range. For example, enter range from 0 to 1 min to determine the drift
corresponding to the first segment and click Ok. The Add Report
Column dialog box appears again. Click Ok. The value for the drift
(mAU/h) is shown in the added column.

Repeat the determination of drift for the remaining time ranges (1 to 2
minutes, 2 to 3 minutes, etc.).

Determine the average drift (mAU/h) for the 20 segments.

Plot drift vs. segment number.

is determined as follows.

While viewing the chromatogram in the Integration View, right-click
on the Table Menu and select Add Column. The Add Report
Column dialog box appears.

Mark Chromatogram from the Categories list and select Signal
Noise from the Variables list.

Click Parameter to open the Parameter Input for “Signal
Noise dialog box.

Select Specific Range check box and enter the desired range. For

example, enter range from 0 to 1 min to determine the noise
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9.

10.

corresponding to the first segment and click Ok. The Add Report
Column dialog box appears again. Click Ok. The value for the signal
noise (mAU) is shown in the added column.

8.3.5.2.12.5.  Repeat the determination of the signal noise for the remaining time
ranges (1to 2 minutes, 2 to 3 minutes, etc.).

8.3.5.2.12.6.  Determine the average signal noise (mAU) for the 20 segments.

8.3.5.2.12.7.  Plot noise vs. segment number.

8.3.5.2.13. Complete the report form (page 15) in Annex 1 of this document.

Observations
Compare the experimental results with the acceptance criteria. If the results are not in agreement with
the set acceptance criteria, repeat the verification procedure. If the results are still not satisfactory,

inform the person responsible for the instrument.
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ANNEX 1

HPLC PERFORMANCE VERIFICATION FORM

This Annex to SOP/CECEM/EQP/02/01, Performance Verification of the Dionex HPLC System with

UV-Vis Diode Array Detector contains the following forms:

Title

Pump flow rate accuracy
Pump flow rate precision
Pump gradient accuracy
Injection precision

Injection volume linearity
Injection carryover

Column oven accuracy
Column oven precision
Column oven temperature stability
Linearity of detector response

Noise and drift

Page
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HPLC PERFORMANCE VERIFICATION FORM: PUMP FLOW RATE ACCURACY

INSTRUMENT INFORMATION

Serial Number:
Laboratory Room:

Manufacturer:
Model:

Set Flow Rate (mL/min): 1.00
Replicate Time (min:sec:csec) Flow rate (mL/min)
Average
Acceptance Criteria: +2% of the set flow rate Result (PASS/FAIL):
Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: PUMP FLOW RATE PRECISION

INSTRUMENT INFORMATION
Manufacturer: Serial Number:
Model: Laboratory Room:
Replicate Retention time (min)
Average
Standard deviation
%RSD
Sample Chromatogram
Acceptance Limit: RSD <1% Result (PASS/FAIL):
Performed by: Checked by:
Signature: Signature:
Date: Date:




@

B

Facultat de Quimica
Annex 1

UNIVERSITAT DE BARCELONA

Departament de Quimica Analitica.

HPLC Performance Verification Form

SOP/CECEM/EQP/02/01 Page 4 of 16

HPLC PERFORMANCE VERIFICATION FORM: PUMP GRADIENT ACCURACY

INSTRUMENT INFORMATION

Manufacturer:

Serial Number:

Model:

Laboratory Room:

Step Expected %A

Observed
Height (mAU)

% Height Ratio | Deviation (%) | Result (Pass/Fail)

Chromatogram

Acceptance Criteria: +1% of the step gradient composition
Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: INJECTION PRECISION

INSTRUMENT INFORMATION

Manufacturer:

Serial Number:

Model:

Laboratory Room:

Replicate

Peak Area

Average

Standard deviation

%RSD

Sample Chromatogram

Acceptance Criteria: RSD <1%

Result (PASS/FAIL):

Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: INJECTION VOLUME LINEARITY

INSTRUMENT INFORMATION

Manufacturer:

Serial Number:

Model:

Laboratory Room:

Injection volume, pL

Peak Area

Peak Area/Injection Volume Ratio

Linear regression equation

R2

r

%RSD (peak area/injection volume ratio)

Chromatogram Overlay
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Linearity Plot
Acceptance Criteria: Result (PASS/FAIL):
r>0.999 r:
%RSD: <5% %RSD:
Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: INJECTION CARRYOVER

INSTRUMENT INFORMATION

Manufacturer: Serial Number:
Model: Laboratory Room:
Replicate Retention time (min) Peak area % Carryover
1 Standard
Blank
2 Standard
Blank
3 Standard
Blank
Average
Chromatogram
Carryover 1

Carryover 2
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Carryover 3

Acceptance Criteria: Carryover <1.5 %

Result (PASS/FAIL):

Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: COLUMN OVEN ACCURACY

INSTRUMENT INFORMATION

Manufacturer: Serial Number:
Model: Laboratory Room:
Set Temperature Measured Corrected Deviation | Result (PASS/FAIL)
(°C) Temperature (°C) Temperature (°C) (°C)
Reading 1
Reading 2
Reading 3
Reading 1
Reading 2
Reading 3
Reading 1
Reading 2
Reading 3
Maximum deviation (°C)
Acceptance Limit: £3 °C maximum deviation
Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: COLUMN OVEN PRECISION

INSTRUMENT INFORMATION

Serial Number:

Manufacturer:
Model: Laboratory Room:
Set Temperature (°C) Measured Temperature (°C) Corrected Temperature (°C)
Reading 1
Reading 2
Reading 3

Observed maximum difference (°C)

Acceptance Criteria:

Maximum Difference: £0.5°C

Result (PASS/FAIL):

Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: COLUMN OVEN TEMPERATURE

STABILITY
INSTRUMENT INFORMATION
Manufacturer: Serial Number:
Model: Laboratory Room:
Set Temperature (°C): 40
Reading Measured Corrected Reading Measured Corrected
Temperature (°C) | Temperature Temperature (°C) Temperature
(°C) (°C)

Minimum Temperature (°C) |

Maximum Temperature (°C)

|

Maximum difference(°C)

Acceptance Criteria: Maximum Difference: +1°C

| Result (PASS/FAIL):

Temperature Stability Graph

Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: LINEARITY OF DETECTOR

RESPONSE
INSTRUMENT INFORMATION
Manufacturer: Serial Number:
Model: Laboratory Room:
Concentration, ppm | Retention time, min Peak Area Peak Area/Concentration Ratio

Linear regression equation
R2
r
%RSD (peak area/concentration ratio)

Chromatogram Overlay
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Detector Linearity Plot

Acceptance Criteria: Result (PASS/FAIL):
r>0.999 r:
%RSD: < 5% %RSD:
Performed by: Checked by:
Signature: Signature:
Date: Date:
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HPLC PERFORMANCE VERIFICATION FORM: NOISE AND DRIFT

INSTRUMENT INFORMATION

Manufacturer: Serial Number:

Model: Laboratory Room:
Segment Noise (mAU) Drift (mAU/h)
Average

Plot of baseline
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Plot of noise

Plot of drift
Acceptance Criteria: Result (PASS/FAIL):
Noise: 0.200 mAU Noise:
Drift : 0.800 mAU/h Drift :
Performed by: Checked by:
Signature: Signature:
Date: Date:
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3. OBJECTIVE
This procedure provides a guideline for the routine maintenance of the Dionex HPLC instrument.
Preventive maintenance activities are performed periodically in order to help maintain the quality

performance of the instrument and prevent failures during analysis.

4. SCOPE

The maintenance activities stated herein only apply to the Dionex HPLC instrument. Maintenance of

the different instrument parts include those shown in Table 1.

Table 1. HPLC parts which require maintenance.

HPLC part Procedure Frequency
Autosampler syringe Replace syringe if contaminated, damaged or
broken
Autosampler needle Replace syringe if contaminated, bent, blunt or

broken

Autosampler needle port seal

Replace needle port seal

if plugged with particulates

Solvent line filter (sinker)

Clean sinker

monthly

Replace sinker

annually or when necessary*

Pump vacuum online
degasser

Clean degasser channels

when necessary*

Pump

Visual inspection for
leakage

when necessary*

Pump pistons seal

Replace piston seal

if there are problems with
pump head leakage or when
necessary™®

Deuterium lamp

Replace lamp

if lamp intensity is too low or if
lamp is defective if lamp is
busted

Flow cell

Clean flow cell

if dirty

Fuse

Replace fuse

if fuse has blown

*depends on the current conditions

5. DEFINITIONS
Not applicable.
6. RELATED PROCEDURES

Instructions for the Operation of the Dionex HPLC System with UV-Vis Diode Array Detector,

SOP/CECEM/EQP/01/01
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7. RESPONSIBILITIES

The user and the person responsible for the instrument shall perform the maintenance activities

described in this document.

8. INSTRUCTIONS
8.1. Replacing the syringe
Replace the syringe when it is damaged, broken or contaminated and the contaminants cannot be
removed by the washing procedure suggested in Section 8.12.
8.1.1. Remove the syringe.
8.1.1.1.  Using water, draw the maximum syringe volume from any sample position desired.
8.1.1.2. Turn off the autosampler and disconnect the power cord.
8.1.1.3. Loosen the retaining screw of the syringe-drive carriage.
8.1.1.4. Carefully twist the barrel of the syringe, unscrewing it from its location.

8.1.1.5.  Once loose, pull the syringe downwards and remove it.

Pressure Regulator

Syringe

Sample loop

Syringe drive carriage

Mounting screw

Waste container

Figure 1. Syringe compartment.

8.1.2. Install the new syringe.
8.1.2.1. Fill the syringe with water and ensure that no bubbles occur in the syringe.

8.1.2.2. Place the seal on the syringe to be inserted.
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8.1.2.3.
8.1.24.
8.1.2.5.

Put the syringe in the drive carriage and carefully screw the syringe into place.
Tighten (hand-tight) the retaining screw.

Turn ON the autosampler. The autosampler performs self-test.

8.2. Replacing the needle of the autosampler

Replace the needle when it becomes bent, blunt, broken or when it is contaminated and the

contaminants cannot be removed by the washing procedure suggested in Section 8.12.

Note: Before replacing the needle, ensure that the needle is in the needle port.

8.2.1. Remove the needle as follows.

8.2.1.1.
8.2.1.2.

8.2.1.3.

8.2.1.4.

8.2.1.5.

8.2.1.6.

8.2.1.7.

8.2.1.8.

Remove the vial carrier.

Turn on the autosampler. The self-test will stop and a Home seek failed error

message appears.

Turn off the autosampler and disconnect the power cord. The needle is now in the

highest position above the needle port.

Loosen the upper enclosure cover that is affixed by four screws. Completely remove

the two screws at the rear and loosen two screws at the front. Push the cover to the

back. (Warning: Before opening the cover, make sure that the autosampler is turned

off and disconnected from the mains).

Remove the fitting screw of the needle capillary from the fluid block using the

supplied 3/16” spanner.

Remove the retaining screw on top of the needle arm using a 17-mm spanner. While

loosening the screw make sure that the needle capillary is situated in the whole of

the screw and is not in its lateral slot (See Figure 2).

Note: Hold the needle guide to let the spring relax slowly. The needle guide is easily
accessible via the sample compartment.

Before you push up and remove the needle from the needle guide, remove the

needle capillary from their 3 guides (on the linear drive, on the MSV enclosure and

on the green printed circuit board (See Figure 2).

Remove the needle guide.
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Retaining screw Linear drive guide MSV guide

Figure 2. Parts of the needle capillary.

8.2.2. Install the analytical needle.

8.2.2.1.

8.2.2.2.

8.2.2.3.

8.2.24.

8.2.2.5.

8.2.2.6.

8.2.2.7.
8.2.2.8.

Via the sample compartment, insert the needle guide from below into the needle
arm.

From the top, insert the needle as far as possible into the needle guide.

Press the needle guide to the top until its thread is visible at the top of the needle
arm. Make sure that the horizontal guide pin is in the corresponding cutout of the
needle arm.

Attach the retaining screw and check by applying slight upward pressure whether
the needle guide can be moved towards the top. Tighten the retaining screw hand-
tight.

Using your thumb and forefinger, bend the needle capillary as close as possible to
the retaining screw by 90° parallel to the needle arm away from the sample
compartment. (Note: Do not break the needle capillary and observe a minimum of
Smm bend radius.)

Press the needle capillary into the respective guide of the green printed circuit
board on the needle arm, after the next bend (factory-default) into the gray guide
at the linear drive and finally into the respective guide at the MSV enclosure.
Tighten the capillary on the fluid block.

Close the enclosure cover.
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8.2.2.9. Install the vial carrier.
8.2.2.10.  Align the needle port. This is necessary whenever the needle or the needle port
has been replaced.
8.2.2.10.1. Go to the Main Menu of the autosampler and select Setup.
8.2.2.10.2. On the Setup menu, select Align Needle Port. You will be prompted to
align the needle port using the arrow keys.
8.2.2.10.3. Use either the up and down cursor keys or the arrow keys to increase or
decrease the indicated value. The up keys move the needle away from the
carrier; the down keys move the needle toward the carrier.
8.2.2.10.4. To accept the modifications, press Enter .. Otherwise, select ESC to

cancel.

8.3.Replacing the needle port seal
Replace the needle port seal when it is plugged with particulates that cannot be removed.
8.3.1. Remove the vial carrier.
8.3.2. Turn ON the autosampler. The self-test will stop and a Home seek failed error message
appears.
8.3.3. Turn OFF the autosampler and disconnect the power cord. The needle is now in the highest
position above the needle port.
8.3.3.1. Remove the top part of the needle port using the 10 mm spanner.
8.3.3.2. Remove the needle port seal that is located in the top part of the needle port.
8.3.3.3. Install the new needle port.
8.3.3.3.1. Using a pair of tweezers, insert the needle port seal into the top part of the
needle port without tilting the seal. The top of the needle port seal must point to
the top of the needle port (See Figure3).
8.3.3.3.2. Tighten (hand-tight) the needle port to its bottom part.
8.3.3.3.3. Install the vial carrier. Align the needle port, if necessary, following

instructions in Section 8.2.2.10.
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Needle port, top

Needle port seal,
top with cavity

Needle port seal,
bottom, even

Needle port, bottom

Needle mounting

N

Figure 3. Needle port with needle port seal.

8.4. Cleaning the solvent line filter frit (sinker)
8.4.1. Remove the filter frit from the solvent line.
8.4.2. Immerse the filter frit in beaker containing methanol.
8.4.3. Place the beaker in an ultrasonic bath for 10 minutes.

8.4.4. Reconnect filter frit in the solvent line.

8.5. Cleaning the vacuum online degasser channels
Clean the degasser channels at regular intervals or whenever chromatograms show reproducible
ghost peaks.
8.5.1. Prepare a 20% nitric acid solution in water.
8.5.2. Replace the column with a backpressure capillary.
8.5.3. Using the commonly used flow rate for normal operation, rinse degasser channels for 1
hour with 20 % nitric acid.

8.5.4. Rinse degasser channels with HPLC-grade water until the pH value is neutral.
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8.5.5. Using the commonly used flow rate for normal operation, rinse the degasser channels with

HPLC-grade acetonitrile for 2 hours.

8.6. Visually inspecting the piston seals for leakage

8.6.1. Disable active rear-seal washing. On the Configuration menu, under Options, select Rear
Seal Wash = No.

8.6.2. Enable seal washing again. Select Rear Seal Wash = Yes.

8.6.3. Remove the silicone tube from the detector of the rear-seal wash system (See Figure 4).
Shake the tube to remove some of the liquid.

8.6.4. Reinstall the silicone tube on the detector.

8.6.5. Set the flow rate necessary to generate a backpressure of approximately 300 bar (30 MPa,
4350 psi).

8.6.6. Observe the air/liquid level in the silicone tube to evaluate possible leakage. If the level
travels the tube, this indicates leakage. If the level remains unchanged, the piston seals seal
tightly. If the level rises or falls, it indicates a leak from one or more of the main piston
seals. In this case, it might be necessary to replace all piston seals and the supporting rings.

Follow the instructions on Section 8.7, Replacing the Piston Seals.

N\

Remove this tube to inspect the pump's
main piston seals for leaks.

™ Liquid reservoir

Figure 4. Liquid reservoir of the rear-seal wash system.
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8.7. Replacing the piston seals
Replace the piston seals whenever there are problems with pump head leakage and when it is
known that the problem is attributed to the piston seal.
8.7.1. Remove the pump heads and pistons as follows.
8.7.1.1. Ifnecessary, purge the pump to remove toxic solvents.
8.7.1.2.  Set the pump flow rate to 0.
8.7.1.3. Disconnect all fluid connections from the pump heads (See Figure 5).
8.7.1.4. Loosen the Allen screws on the two pump heads. Carefully remove the pump heads.
8.7.1.5. Carefully remove the bushing of the seal-washing chamber from the piston
(including the seal). See Figure 6.
8.7.1.6. Remove the bushing with draining device from the piston unit, using the extractor
from the pump’s accessories kit. See Figure 6.

8.7.1.7. Loosen the piston retaining screw using the flat-blade screwdriver. Move the piston

forward, toward the front cover of the pump, and remove it from the enclosure.

Figure 5. Fluid system of the P680 HPLC pump (See Table 2 for the description of each part).
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Table 2. Description of the fluidic system of the HPLC pump.

No. | Description

1 Piston unit

2 Piston retaining screw

3 Bushing with draining device

4 Retaining screw (DR)

5 Rear-seal wash system (piston head bushing)

6 Ring seal

7 Support ring

8 Piston seal

9 Capillary between working head and equilibration head (top)
10 | Outlet valve (includes valve cartridge)

11 | Valve cartridge (identical to No.14)

12 | Working pump head without pressure sensor

13 | Allen screw (I-M4x40)

14 | Valve cartridge

15 | Inlet valve (includes valve cartridge)

16 | Connecting tube

17 | Equilibration pump head with pressure sensor and purge screw
18 | Capillary connection to the mixing chamber/purge block or outlet block

Piston head bushing
Ring seal

Figure 6. The bushing and the ring seal upon removal of the pump head.
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' r Bushing with

draining

o O Piston unit

Figure 7. How to remove the bushing (a) extractor (b) piston and bushing with draining device (c)

removing the bushing with draining device.

8.7.2. Clean the piston by rinsing the piston with water and then with methanol.
8.7.3.  Rub the piston several times with a dry, lint free paper towel.
8.7.4. Remove the piston seals as follows.
8.7.4.1. Use a disassembled piston to remove the piston seal from the pump head. Using a
dummy plug, close the outlet valve on the working pump head.
8.7.4.2. Using a dummy plug, close the boreholes on the equilibration pump head.
8.7.4.3. Insert the piston tip into the piston seal to remove the piston seal. If the piston
cannot be removed, use an M4 screw and insert the screw into the seal.
8.7.4.4. Remove the seal.
Note: Replace also the support ring if the piston seal in the pump head was replaced.
8.7.4.5. To remove the piston seal in the rear seal chamber, remove first the retaining screw
on the rear of the pump head bushing. Use a flat-blade screwdriver to remove the
SCTews.

8.7.4.6. Remove the seal. Use the piston to push the piston seal out of the bushing.
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8.7.5. Reinstall the piston, piston seal and pump head as follows.
8.7.5.1. Take the piston in one hand and slide the new piston seal over the piston.
8.7.5.2. Insert the piston and the piston seal together into the pump head bushing.
8.7.5.3. Remove the piston. The piston seal should remain in the piston head bushing.
8.7.5.4. Install and tighten (hand-tight) the pump head bushing retaining screw.
8.7.5.5. Install the piston in the pump block.
8.7.5.6. Using the flat-blade screwdriver, tighten the piston retaining screw.
8.7.5.7. Slide the bushing with the draining device onto the shaft. Ensure correct orientation of

the bushing. See Figure 8.

Slide the bushing onto the
piston in this direction; ensure
proper orientation.

Figure 8. Correct orientation of the bushing with draining device.

8.7.5.8. Slide the complete pump head bushing over the piston unit.
8.7.5.9. Slide the new support ring and the piston seal onto the piston.
8.7.5.10. Slide the ring seal onto the pump head bushing.
8.7.5.11. Slide the pump head onto the piston (turn and push as necessary) until the second
piston seal is correctly in place.
8.7.5.11.1. Tighten the pump heads with Allen screws.
8.7.5.11.2. Insert the inlet and outlet valves into the working pump head.
8.7.5.11.3. Attach the capillary connections. Hand-tighten first and then tighten them
one-quarter turn using a %4” wrench.

8.7.5.11.4. Attach the solvent line to the inlet valve.
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8.7.5.11.5. Attach the silicone lines of the seal wash system to the corresponding
capillaries.

8.7.5.11.6. Rinse the pump thoroughly using at least 30 mL. HPLC-grade water or pure
organic solution. Open the purge block to prevent the rinsing liquid from
entering the HPLC system.

8.7.5.11.7. Test the pump for leakage following instructions in Section 8.11.

8.8.Replacing the deuterium lamp
Replace deuterium lamp if lamp intensity is too low or if the lamp is defective or is busted.
8.8.1. Remove the deuterium lamp as follows.

8.8.1.1. If the lamp is connected to Chromeleon, select the Disconnect command in
Chromeleon to terminate communication.

8.8.1.2.  Turn off the power of the detector and disconnect the unit from the mains.

8.8.1.3. From the detector’s left-side panel, remove the removable cover. To open, press in
and turn the knurled screw 90° counterclockwise. Open and remove the panel (See
resulting Figure 9). Do not bend the Teflon capillary.

8.8.1.4.  Allow the lamp to cool down.

8.8.1.5. Disconnect the lamp by gently pressing either side of the locking plug.

8.8.1.6. Using a 2.5 mm Allen-key, undo and remove the two lamp retaining screws.
Remove the lamp carefully.

8.8.2. Install the new lamp as follows.

8.8.2.1. Insert the new lamp.

8.8.2.2.  Align the notch on its base with the alignment pin of the lamp housing.

8.8.2.3. Replace the retaining screws.
Note: Avoid touching the glass tube of the lamp.

8.8.2.4. Reconnect the cable.

8.8.2.5. Reinstall the removable cover on detector’s left-side panel.

8.8.2.6. Turn on the detector.

8.8.2.7. On Chromeleon, select GConnect command to restore communication with

Chromeleon.
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Note. Let the new lamp to “run in” for at least 24 hours before starting the first analysis.

’:

Deutarium lamp

Flowe call cover

How call

Knurled retaining scraw

|@\ |©| |®| /

i 7

Figure 9. Side view of the detector showing an open side panel.

8.9. Cleaning the flow cell
Clean the flow cell when it becomes dirty as evidenced by a decrease in detector performance
or unusual noise levels.
8.9.1. Remove the flow cell.

8.9.1.1. If the detector is connected to Chromeleon, select the Disconnect command in
Chromeleon to terminate communication.

8.9.1.2. Turn off the power of the detector and disconnect the unit from the mains.

8.9.1.3.  From the detector’s left-side panel, remove the removable cover. To open, press in
and turn the knurled screw 90° counterclockwise. Open and remove the panel (See
resulting Figure 9). Do not bend the Teflon capillary.

8.9.1.4. Undo the four retaining screws and remove the flow cell cover.

8.9.1.5. Undo the knurled flow cell retaining screw and carefully remove the flow cell

assembly.
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F— e — ==\

Figure 10. Standard flow cell (See Table 3 for the description of each part).
Table 3. Description of the detector flow cell.

No. Description

1 M3x12 screw (DIN 965)

2 Heat exchanger

3 PEEK tubing (0.5 mm ID)

4 PEEK fitting screw (1/16”, 15 mm)
5 M3x23 screw (DIN 965)

6 Lens retaining plate 1

7 Quartz lens

8 Flow cell body

9 Lens retaining plate 2

10 Flow cwll housing

11 Single-part hand-tight fitting
12 Capillary tube (1.58 x 0.25 ID)
13 PEEK double ferrule

14 Flow cell body retaining screw
15 Fitting screw
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8.9.2. Clean the flow cell as follows. Use gloves when handling the detector parts.

Note: To clean the flow cell, follow the steps below and refer to Figure 10 for the part

numbers which are in parentheses. When cleaning the flow cell, only the lens retaining

plates and the lenses may be removed. Do not attempt to remove the flow cell body (8)

from its housing (10). Clean the flow cell body together with the housing.

89.2.1.

89.2.2.

8.9.2.3.

8.9.2.4.
8.9.2.5.

8.9.2.6.

8.9.2.7.

8.9.2.8.

Undo and remove the screws (1) and remove the heat exchanger (2).

Undo and remove the screws (5) and carefully remove the lens retaining plates (6 and
9) and lenses (7). To avoid scratching the lenses, place them on a clean, lint-free cloth
or tissue.

Clean the lenses using a soft, lint-free cloth or tissue and an optical cleaning solution
or isopropanol.

Replace scratched or damaged lenses.

Clean the flow cell body and housing by rinsing the parts with water, isopropanol or
methanol, or placing the entire assembly in an ultrasonic bath.

Reinstall the lenses onto either side of the flow cell body so that the plane faces are on
the inside.

Reinstall the lens retaining plates (6 and 9). Tighten the screws (5) carefully and
evenly, without excessive force.

Check the flow cell for leakage before installing them into the unit. Tighten the screws

(5) if necessary.

8.9.3. Install the flow cell as follows.

8.9.3.1.

8.9.3.2.
8.9.3.3.
8.9.34.

Insert the cleaned flow cell, aligning the notch with the alignment pin of the flow cell
socket.

Reinstall the flow cell cover.

Reinstall the removable cover on the detector’s left side panel.

Turn on the detector and restore the communication with Chromeleon using the

Connect command.
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8.10. Replacing the fuse
8.10.1. Replace the fuse only when the fuse has blown.
8.10.2. Turn off the instrument module.
8.10.3. Disconnect the power cord from its source.
8.10.4. Using a small screw driver, remove the fuse cartridge.
8.10.5. Replace the fuses with fuses of the appropriate ratings.
8.10.6. Reinstall the fuse cartridge.

8.10.7. Reconnect the power cord to its source and turn on the instrument module.

8.11. Testing the pump for leakage

8.11.1. After performing maintenance or repair work on the fluid connections, test the pump for
leakage.

8.11.2. Close the pump outlet with a dummy plug.

8.11.3. Set the upper pressure limit of the pump to 450 bar (6525 psi).

8.11.4. Turn on the pump and set the desired flow rate until the pressure increases.

8.11.5. Observe the change in pressure and decrease the flow as soon as the pressure builds up
(typically between 100 and 200 bar (1450 and 2900 psi).

8.11.6. When the pressure reaches 350 bar (5075 psi), shut off the flow and observe for a drop in
pressure. A properly functioning pump should lose less than 15% of its pressure within
10 minutes after being shut off.

8.11.7. 1In case of leakage, visually inspect the piston seals for leakage and tighten leaking
connections, if necessary.

8.11.8. Reset the upper pressure limit to the value used before the test.

8.12. Observations
8.12.1. When contamination is present and needs to be remedied, the following wash procedure is
suggested. When using methylene chloride or hexane, flush first with isopropanol before
returning to the aqueous mobile phase. After washing with the solvent, check (for example,
by performing blank injection) whether the contaminants were removed before proceeding

to the next wash solvent.
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8.12.1.1. When using buffers, replace the buffer with water and flush the system with water.

8.12.1.2. Flush with 100% methanol.

8.12.1.3. Flush with 100% acetonitrile.

8.12.1.4. Flush with 75%acetonitrile-25%isopropanol.

8.12.1.5. Flush with 100% isopropanol.

8.12.1.6. Flush with methylene chloride.

8.12.1.7. Flush with 100%hexane.

8.12.2. In cases where scheduled maintenance is delayed, instrument use may be put on hold only

if its use is critical to the analysis and if instrument shows uncharacteristic behavior.
Moreover, a notice must be posted about the reason on the delayed maintenance and the

probable date for carrying out the maintenance.
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3. OBJECTIVE
This document provides a guide for the proper operation of the Finnigan LCQ MS detector coupled to

an HPLC instrument.

4. SCOPE
This procedure is applicable to the operation of the Finnigan LCQ MS detector in the ESI mode. The

instrument manual must be consulted for additional information on the use of this instrument.

5. DEFINITIONS
Not applicable.

6. RELATED PROCEDURES
Not applicable.
7. RESPONSIBILITIES

Any person who will use the instrument is responsible for carrying out the operations described in

this document.

8. INSTRUCTIONS
8.1. Instrument Description

ESIPROBE ASSEMBLY FRONT PANEL LEDs

OIL MIST FILTER
GAS BALLAST \ | I -
DIVERT/INJECT VALVE o = !

KNOB
BUTTON AND LEDs
| DIVERT/INJECT —
U VALVE
—
0 m 3
|— OIL INDICATOR
WINDOW
e
FOREPUMP MS DETECTOR COMPUTER DATA SYSTEM

Figure 1. Finnigan LCQ MS system.
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The Finnigan LCQ is a quadrupole ion trap mass spectrometer equipped with atmospheric pressure

ionization (API) source capable of electrospray (ESI) and atmospheric pressure chemical ionization

(APCI) to produce either positive or negative ions. The instrument includes the following

components: forepump, syringe pump, divert/inject valve, MS detector and Xcalibur® data system.

8.1.1. Syringe Pump

The syringe pump can be turned on/off by pressing the Start/Stop button found on the LCQ

instrument front panel or through the Syringe Pump toolbar button at the Tune Plus window of

the computer data system. The syringe is placed on the syringe holder and the pusher block

helps in keeping it in place. When the syringe pump is turned on, the syringe pump LED is

illuminated and the syringe plunger is depressed and liquid flows out of the syringe at a

specified flow rate. The syringe pump is controlled by the computer data system where the

parameters for syringe pump operation can be specified such as syringe type, syringe volume,

syringe ID and flow rate.

SYRINGE
SYRINGE PUSHER PUMP .
SYRINGE HOLDER BLOCK LED sgﬁcs";op

Figure 2. Syringe pump.
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8.1.2. Divert/Inject valve

The Divert/Inject valve button found on the front panel (left side) of the instrument is used to
divert the flow from the HPLC to the MS detector (Detector/Load LED is illuminated) or to
waste (Inject/Waste LED is illuminated) by pressing the Divert/Inject valve button. The
Divert/Inject valve can also be controlled from the Divert/Inject valve toolbar button at the

Tune Plus window of the computer data system.

(oad Inject
| | +———— LEDS
 Devecto SR Waste |

- «———— DIVERTINJECT
VALVE BUTTON

DIVERT/INJECT VALVE

SYRINGE PORT

SAMPLELOOP

Figure 3. Divert/Inject valve.

8.1.3. MS Detector

The MS detector is controlled by a computer-based data system and is capable of performing
various scan modes (MS, MS/MS, MS") and scan types (Full Scan, SIM, ZoomScan). It
operates with an optimal m/z (mass to charge range) of 50-2,000 at different positive and
negative ion polarity modes. The MS detector includes the following components: controls and
indicators, API source, ion optics, quadropole ion trap mass analyzer, ion detection system,
vacuum system and inlet gasses hardware, cooling fans and electronic assemblies. The
necessary switches (main power circuit breaker switch and electronics service switch) are
located at the power panel found on the lower right corner of the right side panel of the detector

(See Figure 4).
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Table 1. MS detector front panel LED description.

Front Panel LEDs

Description

Power

The LED is green when power is supplied to the vacuum system and electronic
assemblies.

Vacuum

The LED is illuminated green when vacuum is OK and the safety-interlock
switch on the API source is depressed (the API flange is secure to the spray
shield).

Communication

The LED is illuminated yellow when a communication link is being established
between the detector and data system.

The LED is illuminated green when the communication link between the MS
detector and the data system has been made.

System

The LED is illuminated yellow whenever the MS detector is in Standby (high
voltage is not supplied to the API source, mass analyzer and ion detection
system but MS detector power is on) mode.

The LED is illuminated green whenever the MS detector is On (high voltage is
supplied to the API source, mass analyzer and ion detection system).

Scan

The LED flashes blue whenever the MS detector is On and scanning ions.

ELECTRONICS MAIN POWER
RESET BUTTON SERVICE SWITCH CIRCUIT BREAKER SWITCH

Figure 4. Power panel.

8.1.4. Data System

The Xcalibur data system provides instrument control and data analysis for the LCQ. From the

Xcalibur homepage, the user can navigate to Instrument Setup, Sequence Setup, Processing

Setup and Results Review pages for designing experiments and review of results.
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8.2. Procedure

8.2.1. Instrument Setup for ESI operation

8.2.1.1. Connect a fused-silica sample tube to the ESI probe

8.2.1.1.1. Remove the ESI probe assembly from the storage box.
8.2.1.1.2. Before installing the ESI probe to the LCQ MS detector, connect first the

fused silica sample tube to the ESI probe as follows. See Figure 5.

\ SAMPLE INLET FITTING

‘ GROUNDED FITTING

|
— ESI PROBE ;] 'E}]M@ 1
— | { [ k|; \_\_,_ J

FERRULE FERRULE
FINGERTIGHT FITTING

SANMPLE TUBE
FUSED SILICA CAPTILARY

Figure 5. ESI/MS plumbing connections for the fused-silica sample tube.

8.2.1.1.3. Using a fused silica cutting tool, cut a 30 cm (12 in.) piece of fused-silica
sample tubing (0.190 mm ID x 0.400 mm OD).

8.2.1.1.4. Insert the fused-silica tube through the exit end of the ESI spray needle and
into the ESI probe. See Figure 6.

8.2.1.1.5. Push the fused-silica sample tube through the ESI probe until it exits the
sample inlet and only about 1.5 inch is left protruding from the exit end of
the spray needle.

8.2.1.1.6. Slide a 0.008 inch ID Kel-F® ferrule, narrow end first, onto the fused-silica
sample tube.

8.2.1.1.7. Slide a (brown) sample inlet fitting (Upchurch 1/16 inch Fingertight fitting)
onto the fused-silica sample tube and into the sample inlet. Tighten the fitting

slightly, but not completely.
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8.2.1.1.8. Slide a (red) Fingertight fitting (1/16 inch Upchurch Fingertight fitting) and a
0.008 inch ID Kel-F® ferrule (wide end first) onto the free end of the fused
silica sample tube.

8.2.1.1.9. Connect the fused silica sample tube and ferrule to the ground fitting holder
by tightening the Fingertight fitting. Ensure the fused-silica sample tube is
held tightly in the grounded fitting by gently pulling the fused-silica sample
tube.

8.2.1.1.10. From the ESI sample inlet, carefully pull the fused silica sample tube
backwards until it is recessed inside the spray needle by approximately 1
mm.

8.2.1.1.11. Tighten the (brown) sample inlet fitting to securely hold the fused-silica

sample tube in place.

'_‘3 FUSED-SILICA
CAPILLARY

(SAMPLE TUBE)

=
7] P—
m
il

e 2
lj—l

el A i N

INLET

T SAMPLE TUBE
THIS DIRECTION

ESI [L
MANIFOL

hd
ESI PROBE
SAMPLE TUEBE

Figure 6. Installing the ESI fused-silica sample tube.

8.2.1.2. If the fused-silica sample tube is already connected and needs to be replaced,
disconnect the fused-silica sample tube from the ESI probe as follows.
8.2.1.2.1. Disconnect the Fingertight fitting from the grounded fitting.
8.2.1.2.2. Disconnect the Fingertight fitting from the ESI probe sample inlet.
8.2.1.2.3. Pull the fused-silica sample tube out of the ESI probe sample inlet.

8.2.1.2.4. Install a new fused silica sample tube as outlined in Section 8.2.1.1.
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ESTFLANGE GROUNDED FITTING ~ SHEATH GAS ESINEEDLE HIGH
3 HOLDER INLET VOLTAGE CONNECTOR

ESIPROBE PROBE RETAINER BOLT
APISTACK CABLE
CONNECTOR
— S '/

AUXILIARY GAS INLET

FLANGE RETAINER BOLT (2x) —__ |

SAMPLE INLET Q

PROBE SLIDE
ADAPTER

SHEATH LIQUID INLET /

API SOURCE DRAIN TUBE

Figure 7. Connections for the ESI probe.

8.2.1.3. Install the ESI probe to the LCQ MS detector.

8.2.1.3.1. Holding the ESI flange in one hand, align the ESI flange with the probe slide
adapter and place it onto the guide rails.

8.2.1.3.2. Slide the ESI probe assembly onto the probe slide adapter and secure
assembly with the knurled fastener that is located on the underside of the
probe slide adapter.

8.2.1.3.3. Remove the Teflon coated septum from the entrance end of the heated
capillary.

8.2.1.3.4.  With one hand, hold the ESI probe on the nozzle side of the probe to keep it
from moving in the flange. With the other hand, connect the high voltage
power cable to the connector labelled HV on th ESI probe. Turn clockwise
the locking-ring on the cable to secure the cable.

8.2.1.3.5. Push the ESI probe assembly against the spray shield.

8.2.1.3.6.  Secure the ESI flange to the spray shield by tightening the two (black) flange

retainer bolts.
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8.2.1.3.7. Connect he sheath gas line and (blue) fitting to the inlet labeled Sheath gas
on the ESI probe.

8.2.1.3.8. Connect the auxillary gas line and (green) fitting to the inlet labeled Aux gas
on the ESI probe.

8.2.2. System Start up

To start the system after a complete shutdown, follow these steps.

8.2.2.1. Turn on the computer, if necessary. Wait until communication is established between
the LCQ and the computer. If everything is connected well, the Instrument Console
displays the value: 2,000. Otherwise, inform the person in charge of the LCQ.

8.2.2.2. Place the main power circuit breaker switch in the On position to start the forepump
and turbomolecular pump.

8.2.2.3. Place the electronics service switch in the Normal (On, |) position. The LEDs found
on the front panel are then illuminated.

8.2.2.4. On the desktop, double click on the LCQ Tune icon to display the Tune Plus window

]-g:l.u as shown in Figure 8. The LCQ is on Standby mode. Allow the system to pump down
for at least one hour. Look on the status panel in the Tune Plus window. Check to see

if the ion gauge pressure is around 1 x 10 Torr and the convectron gauge pressure is
around 1 Torr before starting. Pressures below these values indicates blockage in the
heated capillary. If the ion gauge pressure and convectron gauge pressure are not

within the set limits, inform the person in charge of the LCQ.
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Figure 8. The Tune Plus window, showing the MS detector in the Standby mode.

8.2.2.5. Run the LCQ diagnostics.

8.2.2.5.1. Click on the On/Standby icon to turn on the detector.

8.2.2.5.2. If necessary, specify the ESI source. In the Tune Plus window, Choose Setup >
Change API Source Type. The Change Source Type dialog box appears.
Select the ES| option button. Click 0 K.

8.2.2.5.3. In the Tune Plus window, select Diagnostics > Diagnostics to open the
Diagnostics dialog box.

8.2.2.5.4. Select the Graphs tab.

8.2.2.5.5. Reposition the Diagnostics dialog box such that it does not block the Graph

view as shown in Figure 9.
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Figure 9. Diagnostics dialog box and Graph view.

8.2.2.6. Tune the octapole RF voltage.

8.2.2.6.1. Inthe Test Type text box, select Tune multipole frequency.
8.2.2.6.2. Inthe How many times group box, select the Once option.
8.2.2.6.3. Click on Start button. A frequency function appears in the graph view as

shown in Figure 10. The minimum of the frequency function should lie
between 2400 and 2550 kHz.
8.2.2.6.4. After the octapole tune program is finished, click on the Yes button to accept

the multipole frequency.
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Figure 10. Graph view for the octapole RF voltage tuning.

8.2.2.7. Tune the ring electrode RF modulation.

8.2.2.7.1.
8.2.2.7.2.
8.2.2.7.3.

8.2.2.74.

In the Test Type textbox, select Tune RF modulation.

In the How many times group box, select the Once option.

Click on Start button. The Graph view should look as displayed in Figure 11.
The standing wave ratio switch line should be at 10 V over the entire range;
the detected RF voltage should be a straight line that begins at the origin and
intersects the standing wave ratio switch line near the highest mass line; the
RF voltage modulation should be a curved line that begins at the origin and
intersects the highest mass line at a value between 3.5 and 4.5 V.

Inspect the graph view. If the above three conditions are met proceed to the
next step. If the conditions are met over part of the range but not all of the
range (the curves flatten or change value abruptly), tune the RF voltage
frequency as described in the next step and repeat the tuning of the ring RF

modulation. If the standing wave ratio switch, detected RF voltage and RF
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8.2.2.8.

modulation lines are all flat, this indicates loose connection. Ensure proper
connections of the cables and leads. The spring-loaded pin on the RF voltage
feedthrough should have proper contact with the ring electrode. Repeat the

procedure for tuning the ring RF modulation.

- Tume Plus - Untiled (LIE]
Eile Wew Gl ‘L-«z-- Dispduy Gemp  Disquadties unln

iULl*h:@l

EREFRRE) ) R W ]
¥\\\-— STANDING
- WAVE RATIO
SWITCH
S| pemecTED
RF VOLTAGE

[~ HIGHEST MASS

\\_ RF VOLTAGE

MODULATION

3 LY

Figure 11. Graph view for ring electrode RF voltage modulation tuning.

Tune the ring electrode RF voltage frequency.

8.2.2.8.1. In the Test Type box, select Tune RF frequency. The Continuously option

button in the How many times group box is automatically selected.

8.2.2.8.2. Click on Start button. The Graph view displays several tune functions, a

frequency cursor and a frequency window as shown in Figure 12.

8.2.2.8.3. Allow the program to make at least five passes. Inspect the graph. The

8.2.2.9.

frequency cursor should lie within the frequency window. Click on the Stop

button.

If problems are encountered during the tuning process, inform the person

responsible for the instrument.
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Figurel2. Graph view for ring electrode RF voltage tuning.

8.2.2.10. Test the electronic subsystems (vacuum system, power supplies, lenses, ion
detection system and RF voltage electronics).

8.2.2.10.1. To test all of the electronic subsystems, go to the Diagnostics dialog box,
click on the All tab and select the Everything option. See Figure 13.

8.2.2.10.2. To test an individual subsystem, click on the tab corresponding to that
subsystem and select the appropriate options.

8.2.2.10.3. Click on the Start button to start the diagnostics. The Testing text box
displays a chronological log of all the diagnostic tests.

8.2.2.10.4. After the testing of the subsystem is finished, LCQ displays either Pass or
Fail result. If a Fail result is displayed, consult the person in charge of the
LCQ.

8.2.2.10.5. Close the Diagnostics dialog box.

8.2.2.10.6. Set the system to the Standby mode while it awaits further instructions.
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Figure 13. Diagnostics dialog box.

8.2.3. Tuning the MS detector with your analyte

8.2.3.1. Prepare the tuning solution.

8.2.3.2. Set up the plumbing connections for ESI/MS sample introduction from the syringe

pump into solvent flow from HPLC as shown in Figure 14.

8.2.3.2.1. To set the connections from the grounded fitting to the LC Tee union, connect

an appropriate length of PEEK tubing with a Fingertight fitting to the

grounded fitting (See Figure 15). Connect the other end of PEEK tubing with

a Fingertight fitting to the free end of the LC Tee union.
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Figure 14. ESI/MS plumbing connections for sample introduction from the syringe pump into solvent

8.2.3.2.2.

flow from HPLC.

Set up the plumbing connections for the divert/inject valve and the LC Tee
union. See Figure 15. Connect an appropriate length of PEEK tubing with
Fingertight fitting to port 3 of the divert/inject valve. Connect the other end
of the PEEK tubing with Fingertight fitting to the free end of the LC Tee

union.

PEEK TUBING FINGERTIGHT FITTING

| LC TEE UNION

TO
DIVERT/INJECT —
VALVE (PORT 3)

FINGERTIGHT FITTING I
PEEK TUBING

[wn — FINGERTIGHT FITTING

INFUSION LINE
TO SYRINGE

G

\
«m%—%m— CED

ROUNDED
FITTING

Figure 15. ESI/MS Plumbing connections for the LC Tee union.
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8.2.3.2.3.  Set up the plumbing connections for the syringe. See Figure 16.
8.2.3.2.3.1. Connect a 4 cm segment of Teflon Tube with a fingertight fitting to
the LC union.
8.2.3.2.3.2. At the other end of the LC union, a PEEK tubing and a Fingertight
fitting.
8.2.3.2.3.3. Load a clean, 500 pL Hamilton syringe with 420 pL of the tuning
solution.
8.2.3.2.3.4. Insert the syringe needle into the segment of Teflon tube.
8.2.3.2.3.5. Place the syringe into the syringe holder of the syringe pump.
8.2.3.2.3.6. While squeezing the blue release levers, push the syringe pump
handle forward until it just touches the syringe plunger and lock it
in position.
8.2.3.2.3.7. Connect the PEEK tubing with Fingertight fitting found at the end
of the sample infusion line to the remaining free end of the LC Tee
union. See Figure 15.
FINGERTIGHT FITTING LCUNION FINGERTIGHT FITTING SYRINGE
R | | |
TO LC TEE UNON ¢ {[TIb= -1]}]1]% -
n = S—

PEEEK TUBING

Figure 16. Plumbing connections for the syringe.

8.2.3.3. Have the HPLC ready for the tuning procedure. Consult the HPLC instrument

operation instructions or manual.

8.2.3.3.1. Fill the solvent reservoirs with appropriate solvents.

8.2.3.3.2. Purge the solvent lines.
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8.2.3.3.3. Connect the HPLC outlet to port 2 of the Divert/Inject valve of the LCQ MS
detector. Make sure that the Divert/Inject valve is in the Waste position.
8.2.3.3.4. Set the composition and flow rate of the mobile phase necessary for the tuning
process.
8.2.3.4. In the computer connected to LCQ MS, create your own directory, if necessary.
8.2.3.4.1. From the desktop, go to My Documents > Usuarios and create a folder with
your name.
8.2.3.4.2. Create also subfolders with the following labels: data, tune, method,
sequence and layout.
8.2.3.4.3. To save the data for current analysis, create a new folder with the label in the
following format: YYMMDD where YY stands for the year, MM for month
and DD for day. Save this new folder under the subfolder data.
8.2.3.5. Go to the Tune Plus window and take the MS detector out of Standby mode by
@ turning it ON. Click the ON/Standby button in the toolbar.
8.2.3.6. Check the system vacuum levels by looking at the status panel in the Tune Plus
window. Click on the Display status icon from the toolbar. Make sure that the ion
gauge pressure is below 5 x 10” Torr and the convectron gauge pressure is around 1
Torr before starting. Check also the values for the other parameters (velocity and
power) in the status panel.
8.2.3.7. Record the current values (ion gauge pressure, convectron gauge pressure, velocity,
power) on the Instrument Logbook for Vacuum System of Finnigan LCQ MS.
8.2.3.8. While in the Tune Plus Window, examine the pre-tune ESI settings and change the
parameter values to the desired settings, if necessary.
8.2.3.8.1. If necessary, specify the ESI source. Click Setup on the toolbar and go to
Change API Source Type. In the Source Type dialog box select the ESI
option button. Click OK to return to the Tune Plus Window.
8.2.3.8.2. Click on the ESI Source button in the toolbar. The ESI source dialog box

% appears.

8.2.3.8.3. Input the desired values for the sheath gas flow rate, auxiliary gas flow rate,

spray voltage, capillary temperature, capillary voltage and tube lens offset.




@

UNIVERSITAT DE BARCELONA

B

Facultat de Quimica

Standard Operating Procedure (SOP)

Departament de Quimica Analitica.

SOP/CECEM/EQP/04/01 | Page 20 of 33

8.2.3.84.

8.2.3.8.5.

Click Apply for the changes to take effect and click O K to return to the Tune
Plus Window.

If there is an existing tune file with the same parameters as your current
analysis, you can open this tune file to load the desired parameters. In the
Tune Plus Window, go to File > Open and browse though the saved tune
files. Select the desired tune file and click OK to load the tune file settings.

8.2.3.9. Define the scan parameters as follows.

8.2.3.9.1.
)
8.2.3.9.2.

8.2.3.9.3.
8.2.3.94.

8.2.3.9.5.

8.2.3.9.6.

8.2.3.9.7.

Open the Define Scan dialog box by clicking the Define Scan button in the
toolbar.

In the Scan Description group box, set the following parameters: Mass
Range: Normal, Scan Mode: MS, Scan Type: Full.

Set the MSn Power to 1.

In the Scan Time groupbox, set the desired no. of microscans and max. inject
time.

Select the From/To input method group box and specify the desired Scan
Ranges (m/z).

Ensure that the source fragmentation option is turned off. Confirm that the
Turn On check box is not selected.

Click OK to save the MS detector scan parameters and close the Define Scan

dialog box.

8.2.3.10. Select the profile scan data type from the Control/Scan mode toolbar by clicking on

side.

E the Centroid/Profile button. The profile should look as shown in the icon on the left

8.2.3.11. Select the ion polarity mode depending on your analyte. Click on the

|@| Positive/Negative button to toggle between negative and positive ion polarity mode.

8.2.3.12. Tune the MS detector automatically with your analyte tuning solution infused at 3

ML/min.
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8.2.3.12.1. Set the Divert/Inject valve in the Detector position. Click on the
Divert/Inject button to open the Divert/inject dialog box. Select the
Detector option button. Close the dialog box.

. Click on the Syringe Pump button to display the Syringe Pump dialog box.
Turn on the syringe pump by clicking the Flow Control On. Click 0K to

close the dialog box.

. In the spectrum view, observe the peak (m/z) corresponding to your analyte
of interest.

8.2.3.12.4. Click on the Tune button on the Control/Scan Mode toolbar to display the

@ automatic tuning page. Click on the Automatic tab to automatically tune

the MS detector with your analyte.
8.2.3.12.4.1.  Select the Mass (m/z) option button in the What to Optimize
On group box.
8.2.3.12.4.2. Set the mass peak to optimize on the peak at the m/z of your
parent ion. Double-click on the Mass spin box and type the m/z
value of the parent ion.

8.2.3.12.4.3. Click Start to begin the automatic tuning procedure. The

r following message is displayed: Please ensure the Syringe

pump is full. Click OK to close the message box. Leave the

Tune dialog box open.

8.2.3.12.4.4. Click on the Graph View button in the File/Display toolbar of
the Tune Plus window to display the Graph View. Observe the
Tune Plus window and the Tune dialog box. LCQ displays the
various tests and messages in the Status group box. See Figure
17.

8.2.3.12.45. After the tuning process, take note of the change in signal.
Examine the ESI source parameters and compare the new
settings with the pre-tune settings. If the tuning process is
successful, close the Tune dialog box to return to the Tune Plus

window and save the tune method.
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Figure 17. The Tune Plus window with the Tune dialog box, showing the automatic page.

8.2.3.12.5. The Semi-automatic tune procedure can also be used to tune the MS

detector on individual parameters. To perform the semi-automatic tune, go

to the Semi-automatic tab of the Tune dialog box.

8.2.3.12.5.1.
8.2.3.12.5.2.

capillary voltage).
8.2.3.12.5.3.

Check the Show advanced setting option.

Select the desired parameter to be optimized (for example,

Select the Mass (m/z) option button in the What to Optimize On

group box and type the m/z value of the analyte parent ion.

8.2.3.12.5.4.
8.2.3.12.5.5.

Input the desired Optimization Range and Step.
Click Start to begin the optimization process. The following

message is displayed: Please ensure the syringe pump is full.
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Click OK to close the message box. Leave the Tune dialog box
open.
8.2.3.12.5.6. After the optimization is completed, the Accept Optimized
Value dialog box appears giving the new value for the given
parameter. Click Accept to accept the new value.
8.2.3.12.5.7. After the semi-automatic tune for the desired parameters are
completed, it may be necessary to perform the automatic tuning
procedure. Follow the previously outlined steps for automatic
tuning.
8.2.3.13. Save the ESI/MS tune method as follows.
8.2.3.13.1. Display the Save As dialog box by choosing File > Save As. The File
Summary Info dialog box appears. Type a short description of the tune
method or type the first letter of your name. Click OK. Select your folder
labeled tune.
8.2.3.13.2. Click on the File Name text box and type the name of the tune method for
the analyte of interest. The file name should have the following format:
YYMMDD Name of analyte, where YY stands for year, MM for month and
DD for day.
8.2.3.13.3. Click on Save to save the tune method and return to the Tune Plus window.
8.2.3.14. Print the Tune file by clicking on the Print icon.
8.2.3.15. Turn off the syringe pump. Click on the Syringe Pump icon to display the Syringe
Pump dialog box. Select the Off option button and click Cl0se to return to the Tune
Plus window.
. Set the Divert/Inject valve in the Waste position. Click on the Divert/Inject button
to open the Divert/inject dialog box. Select the Waste option button. Close the

dialog box.
8.2.3.17. Put the MS detector in Standby mode. Click on the On/Standby button.
8.2.3.18. Remove the plumbing connections used for the tuning process but leave the
connection between the HPLC and the Divert/Inject valve.

8.2.3.18.1. Stop the solvent flow from HPLC.
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8.2.3.18.2. Remove the syringe from the syringe holder by pulling the blue release
levers backward. Disconnect the tip of the syringe needle from the Teflon
tubing.
8.2.3.18.3. Disconnect the PEEK tubing connection between the syringe pump and the
LC Tee union. Rinse the PEEK tubing and syringe several times with
methanol.
8.2.3.18.4. Disconnect the PEEK tubing connection between the ground fitting holder
and LC Tee union. Connect an appropriate length of PEEK tubing with
Fingertight fittings from port 3 of the Divert/Inject valve to the grounded
fitting holder (See Figure 20).
8.2.3.19. Flush the sample transfer line and the ESI probe after tuning. Use an unbuffered
solvent or a mixture of 50:50 (v/v) water:methanol. Turn on the MS detector and the
solvent flow from HPLC. Allow the solvent to flush for at least 10 minutes or until
your analyte peak does not have a significant signal as shown in the spectrum
display of the Tune Plus window.
8.2.3.20. After flushing, set the Divert/Inject valve position to Waste and turn off the solvent

flow. Place the MS detector in the Standby position.

8.2.4. HPLC-MS Analysis
The LCQ MS detector is always left turned on and set to the Standby mode when the
instrument is routinely used. Likewise, the computer connected to the LCQ instrument is

always left turned on.

8.2.4.1. Preparations for daily operation
8.2.4.1.1. Check if the oil level in the forepump is between the minimum and maximum oil
level marks. The oil level can be viewed from the oil level indicator window
located at one side of the forepump.

8.2.4.1.2. Before starting with the analysis, make sure that the ion gauge pressure is around

1 x 10” Torr and the convectron gauge pressure is around 1 Torr.
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8.2.4.2. Instrument Setup
8.2.4.2.1.

Install the column in the HPLC instrument.

8.2.4.2.2. Setup the plumbing connections as shown in Figure 18.

8.2.4.2.2.1. Toset the connections from the Divert/Inject valve to the grounded

fitting, connect a PEEK tubing fitted with a Fingertight fitting to port 3

of the Divert/Inject valve. Connect the other end of the PEEK tubing

with Fingertight fitting to the free end of the grounded fitting.

-

|
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Figure 18. ESI/MS plumbing connections for HPLC-MS analysis.

8.2.4.2.2.2. To set the connections from the Divert/Inject valve to the HPLC column

outlet, connect a PEEK tubing with Fingertight fitting to port 2 of the

Divert/Inject valve. Connect the other end of the PEEK tubing with

Fingertight fitting to the HPLC column outlet.

8.2.4.2.3. Create a method (for conditioning the column and for chromatographic

separation) in the HPLC instrument if there is no stored method corresponding to

your analysis.

8.2.4.2.4. Condition the HPLC column and allow the column and the system to equilibrate

for at least 15 minutes before starting.
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8.2.4.3. Creating/Modifying an Instrument Method

8.2.43.1.
X

8243.2.
8.2.4.3.3.

8.2.4.3.4.

8.2.435.

To create an instrument method for MS detection, go to computer desktop and
double-click on the Xcalibur icon. The Xcalibur Roadmap Homepage appears as
shown in Figure 19.

Click on the Instrument Setup icon. The Instrument Setup window appears.

Under the New Method tab, select the experiment type (usually General MS or

MSH).

Specify the desired settings for the following:

MS Detector Setup: Define the acquire time (equivalent to the time when the
HPLC gradient ends), number of segments, start delay time (normally 0
min.), n0. of scan events, tune method and scan event settings (such as
mass range, scan mode, scan type, polarity and data type (normally
Centroid). If the MS/MS scan mode is selected, Click on Parent Masses to
specify additional settings such as parent mass, isolation width,
%normalized collision energy, activation Q and activation time. The
source fragmentation group boxes are usually left unchecked.

Syringe Pump: Leave the field boxes unchecked.

Divert valve: Leave the field box unchecked if the divert valve will not be used.
Otherwise, check on the fieldbox and define the time when the flow from
HPLC will be diverted to the MS detector or to waste.

Contact Closure. The default settings are displayed. Change the settings if

desired.

Summary: The default settings are displayed. Change the settings if desired.

Save the method. Click on File>Save As or click on the Save icon. The File Save
Audit Trail dialog box appears. Type comments for the method or type the first
letter of your name. Click Continue to close the dialog box. Select the method
folder in your directory and type the name of the method. Click OK to end the

saving process.
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8.2.4.3.6. To modify a previously defined method, click on File> Open and browse through
the methods which you want to modify. Make the necessary modifications and

save the changes afterwards.

;,:(: Roadmap - Home Page - =10 x|
File Actions View Tools GoTo Help
[l | |zl vl 2|
Status | Acquisition Queue |
- Run Manager
No Devices
Sequence: ON-LINE y =5
Samt:nle Name: = ffgy—_
Working On: a mMmMmra | i
Position: a0l | S e
Fioaillg;e: 2] .! (= lﬂ U u U (& f“
Inst; Melhod: Instrument ‘ Processing
Setup . Setup
Sequence
Setup
ResulfssReview
2 = o
°‘\. I || Il ‘k )
5
Qual
Browser Browser Browser

Figure 19. The Xcalibur Roadmap homepage.

8.2.4.4. Creating/Modifying a Sequence File
8.2.4.4.1. Select Sequence Setup from the Xcalibur homepage.
8.2.4.4.2. In the sequence setup window, specify the parameters necessary for sample
acquisition.
Sample Type: select from Unknown, Blank or QC (select Unknown for
normal operations)
Sample Name: description of the sample
File Name: name of the file to contain the sample data (usually in the format
YYMMDD xx, where YY stands for the year, MM for month,
DD for day and xx for the file number, (for example, 01)).
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8.2.4.4.3.

8.2.4.4.4.

Inst. Method- instrument method to be used for data acquisition (selected
from the file of stored methods)
Path: path to the raw file that Xcalibur creates for the sample data (choose
from your folder labeled data)
Save the sequence setup in the sequence folder found in your directory. Click
on File > Save As. The File Summary Info dialog box appears. Type a short
description for the sequence or type the first letter of your name. Type the name
of the sequence. Click Save to complete the saving process.
To modify a stored sequence file, open the sequence file and make the necessary
changes directly on the corresponding field boxes. Click on the Save icon to
save the changes. To rename the sequence, click on File > Save As and browse
through the folders where to save the sequence and type the new name of the

sequence. Click Save to complete the saving process.

8.2.4.5. Data acquisition

8.2.4.5.1.

8.2.4.5.2.

8.2.4.5.3.

8.2.4.54.

Before starting with the HPLC run, ensure that the initial conditions for the
chromatographic run has already been attained. Allow the system to equilibrate
for at least 15 minutes.

Take the MS detector out of the Standby mode. Open the tune file for your
analyte. While in the Tune Plus window, click on the DivertInject valve button
and select the Load position to divert the solvent flow to the detector. Close the
Tune Plus window.

Go to the Sequence Setup window of the current analysis. Wait for the status to
display Ready to Download before running the current sequence.

The samples in the current sequence may be run individually or in group. Select

Run Sample to run a single sample or Run Sequence to run several samples.

8.2.4.5.4.1. To run a single sample, click on its row number. The sample row is

highlighted. Click on the Run Sample button in the toolbar to display
the Run Sequence dialog box.
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8.2.4.5.4.2. To run a sequence, highlight the samples you want to run. Click on the
'E* left-most column of the first sample and drag to the last sample to be run.
Click on the Run Sequence button in the toolbar to display the Run
Sequence dialog box.
8.2.4.5.5. In the Run Sequence dialog box, make sure that the following options are
selected:
Acquisition Options. Start When Ready
Processing Actions: Quan
Programs. Run Synchronously PreAcquisition
After Sequence Set System: On
8.2.4.5.6. Click OK to start the sequence. Wait for the status to display Waiting for
contact closure before starting the sequence in HPLC.
8.2.4.5.7. Go to the HPLC instrument and start the sequence program. When the sequence
in HPLC has started, the status on the Xcalibur Sequence Setup displays

Running.
8.2.4.6. Data processing with Qual Browser

8.2.4.6.1. Viewing a Chromatogram

Data can be viewed as soon as data acquisition starts. Use the Qual Browser to

view the data. Press F5 to update the data display for the current data.
8.2.4.6.1.1. Select Qual Browser from the Xcalibur homepage.

8.2.4.6.1.2. Choose File > Open and browse through the data files and double-click

on the file name to open a cell corresponding to the data file.

8.2.4.6.1.3. To view the chromatogram, click on the pin icon to make the cell active
(the pin background turns green and the pin appears stuck into the
screen). Right-click in the cell and choose View> Chromatogram from

the popup context menu.




Facultat de Quimica
@ Standard Operating Procedure (SOP)

UNIVERSITAT DE BARCELONA

@ Departament de Quimica Analitica.

SOP/CECEM/EQP/04/01 | Page 30 of 33

8.2.4.6.1.4. Specify the chromatogram ranges to display the chromatogram. Right-
click on the cell (with the chromatogram active or pinned) and select the
Ranges option from the popup context menu. The Chromatogram

Ranges dialog box appears as shown in Figure 20.

8.2.4.6.1.5. Under Ranges, select the Scan Filter appropriate for your analyte and the
Plot Type (usually Mass Range). Enter the desired value for the Range/s.

8.2.4.6.1.6. Click on the Automatic Processing tab to apply smoothing action to
the active plots in the chromatogram view. To enable smoothing, check
on Enable. Under the Type option, select Gaussian and enter the

desired value of points for chromatogram smoothing.
8.2.4.6.1.7. Click OK to apply the changes to display the chromatogram.

8.2.4.6.1.8. Close the Chromatogram Ranges dialog box.

Chromatogram Ranges
Ranges I Automatic processing I
Range
Time range [minutes): |1 652 42 r iE‘
Type Range Scan filter I Delay [min] | Scale FRaw file
TIC - + ¢ Full ms2 363.30@40.00 [ 150...  0.00 - c:\wcalibur\e
Mass Range 100.0-375.0 + ¢ Full ms2 363.30@40.00 [ 150... 0.00 - c:\xcaliburle
D R
D R
D R
D R
o- . .
4| | i
—Flat propeti
Baw file: In:'\w:a\ihur\examples\data\sternidsﬂﬁ,raw :I J Detectar |M5 vI
Scan fiter: |+ c Full ms2 363.30¢2:40.00 [ 150.00-375.00] ;I Peak algorithm: IIEIS vI
Flat type: |TIC = |- =] [Mass Range =l Detay (min J0.00
Rangsls) [100.0-375.0 Fir seale 1o [1000000.00
T = |

Figure 20. The Ranges page of the Chromatogram Ranges dialog box.
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8.2.4.6.2. Viewing a Spectrum

8.2.4.6.2.1.
I

8.2.4.6.2.2.
|

8.2.4.6.2.3.
8.2.4.6.2.4.
8.2.4.6.2.5.
8.2.4.6.2.6.
8.2.4.6.2.7.

8.2.4.6.2.8.

To view the spectrum of a given chromatographic peak, add an
additional cell to the chromatogram cell in the Qual Browser window.

Click on the Insert cells right icon found on the toolbar.

On the added cell, click on the pin button to activate the cell. Right-click

on the cell and select View > Spectrum from the popup context menu.

Select the peak for which the spectrum is to be shown. Click and drag the
cursor in the chromatogram cell from left to right across the desired

chromatogram peak.

Release the mouse button and the mass spectrum is displayed in the

spectrum cell.

To subtract background spectra from one side (one range) or both sides
(two ranges) of the chromatographic peak of interest, right-click on the

active spectrum view.
Select Subtract Spectra > 1 (or 2) range from the popup context menu.

Click and drag the cursor to the representative baseline region close to

the peak of interest. Release the mouse button.

If the 2 Range option was chosen, choose another region on the other
side of the peak of interest. Release the mouse button. The new spectrum

is displayed in the active spectrum cell.

8.2.4.6.3. Integrating Chromatograms

8.2.4.6.3.1.

While in the Qual Browser window, click on the pin icon to activate the

chromatogram cell.
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8.2.4.6.3.2.

-

8.2.4.6.3.3.

Al

8.2.4.6.3.4.

8.2.4.6.3.5.

8.2.5. System Shutdown

To determine the peak area automatically, click on the Toggle Peak
Detection in this Plot toolbar button. The peaks are detected and
integrated using the current peak detection and integration settings. To
undo automatic peak detection, click again on the Toggle Peak
Detection in this Plot toolbar button.

To add and integrate a peak manually on the chromatogram, click on the
Add Peaks toolbar button. Drag the Add Peaks cursor horizontally
across the start and end baseline points of the peak that you want to
detect and integrate. Click the Add Peaks toolbar button again to restore
the default cursor.

To delete peaks, click on the Delete Peaks toolbar button. Move the
Delete Peaks cursor within the peak boundary of the peak you want to
delete and click on it. To restore the default cursor, click again on the
Delete Peaks toolbar button.

To display the peak labels (retention time, peak area, etc.) on the
chromatogram, right-click on the cell and choose Display Options. In
the Display Options dialog box, click on Labels tab and check the box/es

corresponding to the desired labels that will appear in the chromatogram.

8.2.5.1. Setting the system in standby condition

If the LCQ system will be used again after a short period of time (such as overnight or

weekends), leave the system in standby condition.

8.2.5.1.1. Ensure that data acquisition is already finnished. Close the Sequence Setup and

Qual Browser windows. Open the Tune Plus Window.

8.2.5.1.2. After the analysis, flush the sample transfer line and the ESI probe with an

unbuffered solvent or a mixture of 50:50 water:methanol.

8.2.5.1.3. Divert the solvent flow to waste by pressing the Inject button in front of the

instrument. Alternatively, go to the Tune Plus window, and select the
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Divert/Inject valve button in the toolbar. In the Divert/Inject Valve dialog box,
click Inject button and close the dialog box.
8.2.5.1.4. From the Tune Plus window, click on the Control/standby button to put the MS
detector in Standby mode.
8.2.5.1.5. Purge (decontaminate) the oil in the forepump if the pump was not purged after
the previous operation. The MS detector must be in the Standby mode and the
Divert/Inject valve in Waste position.
8.2.5.1.5.1. Open the gas ballast knob on the forepump by turning the knob
counterclockwise.
8.2.5.1.5.2. Allow the pump to run for at least 10 minutes with the gas ballast valve
open.
8.2.5.1.5.3. Close the gas ballast knob by turning it clockwise until you feel
resistance.
8.2.5.1.6. Leave the MS detector power on.

8.2.5.1.7. Leave the computer turned on and do not close the Instrument Console window.

8.2.5.2. Shutting down the system completely.
8.2.5.2.1. Set the MS detector first in Standby mode.
8.2.5.2.2. Place the electronics service switch (located on the power panel) in the Service
(OFF) position. See Figure 4.
8.2.5.2.3. Place the main power circuit breaker switch (located on the power panel) in the
OFF (O) position.
8.2.5.2.4. Unplug the power cord of the MS detector.
8.2.5.2.5. Turn off the helium gas.
8.2.5.2.6. Turn off the nitrogen gas.
8.2.5.3. In case of an emergency, shut off all the power to the MS detector by placing the main

power circuit breaker switch in the Off (O) position.
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INSTRUMENT LOGBOOK FOR VACUUM SYSTEM OF FINNIGAN LCQ MS
Date lon gauge pressure | Convectron gauge | Velocity | Potential Capillary Name Comments
(x 10 torr) pressure (Torr) | (r.p.m.) (W) Temperature (°C)
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SAMPLES LOGBOOK FOR FINNIGAN LCQ MS

Date

Name

Samples

APl Source/Mode
(ESlor APCI/
Positive or Negative)

Comments
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1.

2.

OBJECTIVE

This SOP provides a guide on how to verify the performance of the LCQ MS detector in order to
demonstrate that it is operating satisfactorily during normal operations. The verification includes
checking the vacuum levels and electronic system and performing calibration and tuning for signal
optimization. By performing a system check, the user will know at the start whether the instrument is
operational or not, and there is less chance of interrupted work due to sudden instrument breakdown.

Performance verification will ensure the quality of the instrument and the measurements made.

SCOPE

This procedure is applicable to all types of determinations which involve the use of this instrument.
Checking the vacuum system levels is a prerequisite before analysis. The diagnostic test for the
electronic system is done on a regular basis or whenever there is system failure. Calibration (using

caffeine, MRFA and Ultramark 1621) and tuning (using reserpine solution) is performed periodically.

DEFINITIONS
Not applicable.

RELATED PROCEDURES
Instrucciones para la Calibracion y Tuning del Espectrometro de Masas LCQ (Finnigan), PNT

0351000 APR/103

RESPONSIBILITIES
Any person who uses the instrument should perform the system check. If a problem is encountered

during the check, inform the person responsible for the instrument.
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6. INSTRUCTIONS
6.1. Verifying the system vacuum levels
The vacuum system level must always be checked before starting any analysis. Vacuum
manifold pressures are measured by the ion gauge and convectron gauge pressure. Check
the vacuum manifold pressure levels as follows:
@bl 6.1.1.  On the desktop, double click on the LCQ Tune icon to display the Tune Plus window.
™ 6.1.2. In the Tune Plus window, click on the vacuum button or choose Setup > Vacuum in order
to display the vacuum dialog box. Verify that the ion gauge pressure is around 1 x 107
Torr and the convectron gauge pressure is around 1 Torr. Record the values in the
instrument logbook.
6.1.3. If the pressure is too high, check whether the API flange is secured to the spray shield and
check for loose connections. Pressures below these values may indicate partial or total

blockage of the heated capillary. Clear the blockage on the heated capillary.

6.2. Verifying the instrument electronic system
The instrument electronic system is verified by performing the diagnostic test. Run the diagnostic
test as follows:
IE',T' 6.2.1.  On the desktop, double click on the LCQ Tune icon to display the Tune Plus window.
. 6.2.2.  Click on the On/Standby icon to turn on the detector.
6.2.3. In the Tune Plus window, select Diagnostics > Diagnostics to open the Diagnostics
dialog box.
6.2.4.  Select the Graphs tab.
6.2.5. Reposition the Diagnostics dialog box such that it does not block the Graph view as

shown in Figure 1.
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Figure 1. Diagnostics dialog box and Graph view.

6.2.6. Tune the octapole RF voltage as follows:
6.2.6.1. Inthe Test Type text box, select Tune multipole frequency.
6.2.6.2.  Inthe How many times group box, select the Once option.
6.2.6.3.  Click on Start button. A frequency function appears in the graph view as
shown in Figure 2. The minimum of the frequency function should lie
between 2400 and 2550 kHz.
6.2.6.4.  After the octapole tune program is finished, click on the Yes button to

accept the multipole frequency.




@

UNIVERSITAT DE BARCELONA

B

Facultat de Quimica

Standard Operating Procedure (SOP)

Departament de Quimica Analitica.

SOP/CECEM/EQP/05/01 Page 5 of 9

=

Tune Plas - Untitled _‘],']

Hile View Contol ScanMede Display Setup  Disgnostics Help

B

1) 3 5 £ =

R TenePus |

0 Do you want ta accept the new octapole frequency?

(o]

Figure 2. Graph view for the octapole RF voltage tuning.

6.2.7. Tune the ring electrode RF modulation as follows:

6.2.7.1.
6.2.7.2.
6.2.7.3.

6.2.74.

In the Test Type textbox, select Tune RF modulation.

In the How many times group box, select the Once option.

Click on Start button. The Graph view should look as displayed in Figure
3 with the following characteristics: the standing wave ratio switch line
should be at 10 V over the entire range; the detected RF voltage should be
a straight line that begins at the origin and intersects the standing wave
ratio switch line near the highest mass line; the RF voltage modulation
should be a curved line that begins at the origin and intersects the highest
mass line at a value between 3.5 and 4.5 V.

Inspect the graph view. If the above three conditions are met proceed to the
next step. If the conditions are met over part of the range but not all of the
range (the curves flatten or change value abruptly), tune the RF voltage
frequency as described in the next step and repeat the tuning of the ring RF
modulation. If the standing wave ratio switch, detected RF voltage and RF
modulation lines are all flat, this indicates loose connection. Ensure proper

connections of the cables and leads. The spring-loaded pin on the RF
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voltage feedthrough should have proper contact with the ring electrode.

Repeat the procedure for tuning the ring RF modulation.
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Figure 3. Graph view for ring electrode RF voltage modulation tuning.

6.2.8. Tune the ring electrode RF voltage frequency.
6.2.8.1. Inthe Test Type box, select Tune RF frequency. The Continuously option button in
the How many times group box is automatically selected.
6.2.8.2. Click on Start button. The Graph view displays several tune functions, a frequency

cursor and a frequency window as shown in Figure 4.
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Figure 4. Graph view for ring electrode RF voltage tuning.

6.2.8.3. Allow the program to make at least five passes. Inspect the graph. The frequency
cursor should lie within the frequency window. If this is true, click on the Stop
button and exit from the diagnostic program. Otherwise, the ring electrode RF
voltage frequency needs to be adjusted manually. Inform the person responsible for
the instrument in who will perform the necessary adjustments. The adjustment of the
ring electrode RF frequency is done as follows:
6.2.8.3.1. Open the left front door of the MS detector.
6.2.8.3.2. Using a Philips screw driver, remove the air deflector to expose the tuning stud.
See Figure 5.
6.2.8.3.3. Using a wrench, loosen the 9/16-in. lock nut that holds the tuning stud in place.
6.2.8.3.4. Using a screw driver, turn the tuning stud until the frequency cursor lies
slightly to the left of the center of the frequency window. (The cursor should
shift slightly to the right when the air deflector is reinstalled).
6.2.8.3.5. Tighten the 9/16-in. lock nut.
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6.2.8.3.6. Reinstall the air deflector and close the left front door of the MS detector.
Make sure that the frequency cursor is still within the frequency window. If
necessary, repeat the abovementioned steps.

6.2.8.3.7. Click on the Stop button to stop the ring electrode RF voltage frequency tune

program.

9/16-IN.
LOCK NUT

TUNING
STUD

Figure 5. Ring electrode RF voltage tuning stud (with air deflector removed).

6.2.8.4. Perform diagnostic test on each of the electronic subsystems (power supplies, API
and temperatures, lenses, and RF voltage electronics). From the Diagnostics dialog
box, select the subsystem to be tested and click on the Start button to start the
diagnostics. The results (Pass or Fail) of the test are displayed in the Testing text
box. If the diagnostics indicate a problem, the maintenance procedure indicated by

the LCQ diagnostics must be performed by authorized personnel.

6.3. Calibration and tuning
Calibration and tuning of the LCQ MS must be done by following the instructions found on the
document /nstrucciones para la Calibracion y Tuning del Espectrometro de Masas [CQ
(Finnigan) (PNT 0351000 APR/103). After calibration, the diagnostic test must be run again to

check if the system operates satisfactorily.
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3. OBJECTIVE
This procedure provides a guideline for the routine maintenance of the LCQ MS detector.

Preventive maintenance activities are performed periodically in order to help maintain the

quality performance of the instrument and prevent failures during analysis.

4. SCOPE

The maintenance activities stated herein only apply to the LCQ MS detector. Maintenance of

the different instrument parts, as suggested by the vendor, include those shown in Table 1.

Table 1. LCQ MS detector parts which require maintenance.

MS detector component

Procedure

Frequency

API source

Flush (clean) sample transfer line,
sample tube, and API probe

Daily

Flush (clean) heated capillary

Daily (or more often*)

Flush (clean) spray shield

Daily (or more often*)

Clear the heated capillary

If heated capillary is partially
obstructed

Replace heated capillary

If heated capillary is totally
blocked or if heater fails

Clean API stack (spray shield,
tube lens and skimmer)

As needed*

Replace sample tube

If sample tube is broken or
obstructed

Rotary vane-pump
/forepump

Purge (decontaminate) oil

Daily

Add oil

If oil level is low

Every 3 months or if oil is cloudy

Change oil or dark colored
Ton optics Clean octapoles and inter- As needed*
octapole lens
Mass Analyzer Clean mass analyzer Yearly (or as needed)*

Ion detection system

Clean ion detection system
(electron multiplier and
conversion dynode)

Whenever the top cover plate of
the vacuum manifold is removed

Replace electron multiplier anode
and cathode

If noise in spectrum is excessive
or proper electron multiplier gain
cannot be achieved

Turbomolecular pump

Change oil reservoir

At least once a year

Replace turbomolecular pump

if turbomolecular pump fails

Cooling fans Clean fan filter Every 4 months

Fuses Replace fuse If fuse has blown
Electronic modules Replace electronic module If electronic module fails
PCBs Replace PCB If PCB fails

lon gauge

Replace ion gauge

If ion gauge fails

*depends on analytical conditions
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5. DEFINITIONS
Not applicable.

6. RELATED PROCEDURES
Not applicable.

7. RESPONSIBILITIES

The person/s responsible for the instrument and/or a qualified personnel should perform the

maintenance activities described in this document.

8. INSTRUCTIONS
8.1. API Source Maintenance

8.1.1. Clearing a blocked heated capillary

A blocked heated capillary is suspected when the pressure in the capillary-skimmer

region (as measured by the convectron gauge) drops considerably below 1 Torr.

8.1.1.1.
8.1.1.2.

8.1.1.3.

8.1.14.
8.1.1.5.

8.1.1.6.

8.1.1.7.

8.1.1.8.

8.1.1.9.

8.1.1.10.

Turn off the solvent flow from the liquid chromatograph.

Place the electronic service switch in the Service (OFF, O) position to turn off
the non-vacuum system voltages.

Loosen the two flange retainer bolts that secure the APCI or the ESI flange to
the spray shield.

Pull back the ESI or APCI flange from the spray shield.

Clear the bore of the heated capillary by inserting and withdrawing the 28
gauge, 10-in hypodermic tube in the accessory Kkit.

Fill a spray bottle with 50:50 HPLC-grade methanol:water solution. From a
distance of 10 cm from the entrance end of the heated capillary, spray a small
amount of the solution down the bore of the heated capillary.

Repeat steps 8.1.1.5. and 8.1.1.6. several times.

Push the ESI or APCI flange against the spray shield.

Secure the ESI or APCI flange to the spray shield with the two flange retainer
bolts.

Place the electronics service switch in the Normal (On, | ) position to turn on

the non-vacuum system voltages.

SOP/CECEM/EQP/06/01 Page 4 of 33
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8.1.2. APCI probe maintenance
Clear the sample APCI tube when it becomes obstructed with salt precipitates. When
it is broken, replace the sample tube. The APCI probe is disassembled for cleaning or
replacing a part.
8.1.2.1. Disassemble the APCI probe assembly as follows:
8.1.2.1.1. Remove the corona discharge needle by pulling it free from the corona
discharge needle assembly. Store the needle by inserting it into one of the
foam walls of the APCI probe assembly storage container.
8.1.2.1.2. Remove the APCI probe from the API flange as follows.
8.1.2.1.2.1. Hold the APCI flange with one hand and unscrew and remove
the APCI manifold from the APCI probe.
8.1.2.1.2.2. Loosen the probe retainer bolt that holds the APCI probe in the
APCI flange.
8.1.2.1.2.3. Remove the APCI probe from the interior of the APCI flange by
gently pushing the probe from the outside of the flange. Do not
disconnect the heater wires.
8.1.2.1.3. Remove the heater coil and quartz insulator from the vaporizer. Use an
Allen wrench to remove the socket-head screw that secures the heater
retainer to the vaporizer casing.
8.1.2.1.4. Disconnect the green electrical ground wire from the vaporizer flange

using a Phillips screwdriver.

GROUND

HEATER
APC| MANIFOLD WIRE
colL HEATER
0.625N, QUARTZ RETAINER
O-RING INSULATOR
0.814-IN.
0,185-N,
O-RING O-RING
l e s
A\, W W W S W T T - _lw
| P — — T
1% ]
SAMPLE \
TUBE VAPORIZER
APCI NOZZLE TUBE
SAMPLE TUBE AUXILIARY SHEATH
INLET EITTING GASTUBE  GASTUBE 0,185-IN, VAPORIZER
O-RING VAPORIZER
CLANGE CASING

Figure 1. Cross sectional view of the APCI probe.
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8.1.2.2. Clean the APCI probe components as follows:

8.1.2.2.1.

Complete the disassembly of the APCI probe.

8.1.2.2.1.1. Unscrew and remove the vaporizer casing from the vaporizer

manifold.

8.1.2.2.1.2. Unscrew and remove the APCI nozzle from the vaporizer

manifold.

8.1.2.2.1.3. Unscrew and remove the auxiliary gas tube from the vaporizer

manifold.

8.1.2.2.1.4. Unscrew and remove the sheath gas tube from the vaporizer

8.1.2.2.2.

8.1.2.2.3.

8.1.2.24.

8.1.2.2.5.

8.1.2.2.6.

8.1.2.2.7.

8.1.2.2.8.

8.1.2.2.9.

manifold.

Remove and check the condition of the 0.185- in. ID O-ring on the APCI
nozzle and the 0.614-in. ID O-ring and a 0.625-in. ID O-ring on the
auxiliary gas tube. Replace the O-rings if necessary.

Clean the APCI components with a 50:50 methanol:water solution and a
lint-free swab. Allow the components to dry and place them on a lint-free
tissue.

Reinstall the 0.614-in. and 0.625-in. O-rings on the auxiliary gas tube and
the 0.185-in. O-ring on the APCI nozzle.

Reinstall the sheath gas tube by gently screwing (finger-tight) it into the
vaporizer manifold.

Reinstall the auxiliary gas tube by gently screwing (finger-tight) it into the
vaporizer manifold.

Reinstall the APCI nozzle by gently screwing (finger-tight) it into the
vaporizer manifold.

Reinstall the vaporizer casing by gently screwing (finger-tight) it into the
vaporizer manifold.

If the sample tube will be replaced, go to the next section otherwise

proceed to Section 8.1.4.5.

SOP/CECEM/EQP/06/01 Page 6 of 33
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Figure 2. APCI sample tube connection.

8.1.2.3. Replace and install the APCI sample tube as follws:
8.1.2.3.1. Remove the APCI sample tube from the APCI manifold.

8.1.2.3.1.1.

8.1.2.3.1.2.

8.1.2.3.1.3.

Remove the sample tube inlet fitting, the 0.239-in. ID O-ring
and the sample tube from the APCI manifold using a 3/8-in.
open-end wrench. See Figure 2.

Remove the exit-end nut, the 0.016-in ID PEEK ferrule, and
the sample tube from the sample tube inlet fitting.

Discard the old sample tube.

8.1.2.3.2. Install the APCI sample tube.

8.1.2.3.2.1.

8.1.2.3.2.2.

8.1.2.3.2.3.

8.1.2.3.24.

8.1.2.3.2.5.

8.1.2.3.2.6.

8.1.23.2.7.

Cut a 15 cm (6 in.) piece of fused-silica tubing (150 um ID, 390
pum OD) using a fused-silica cutting tool.

Slide the exit-end nut and ferrule onto the length of the fused-
silica tubing.

Check the condition of the 0.239-in ID O-ring on the sample
tube inlet fitting. Replace the O-ring if necessary.

Insert the fused-silica sample tubing into the sample tube inlet
fitting.

Slide the exit end nut and ferrule down the fused-silica tubing
and into the sample tube inlet fitting.

Tighten the exit end-nut to secure the new sample (fused silica
tubing).

Gently slide the sample tube through the sample inlet of the
APCI manifold. Use a 3/8-in. open-end wrench to tighten down

the sample tube inlet fitting and compress the O-ring.

SOP/CECEM/EQP/06/01 Page 7 of 33
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8.1.2.3.2.8. Unscrew and remove the vaporizer casing from the vaporizer
flange to expose the nozzle.

8.1.2.3.2.9. Gently slide the sample tube through the sheath gas tube of the
APCI probe and out the APCI nozzle. Watch for the smaple
tube to exit the APCI nozzle. Screw the APCI manifold into the
APCI probe (sheath gas tube).

8.1.2.3.2.10. Use a fused-silica cutting tool to cut the exit end of the sample
tube so that approximately 1 mm protrudes past the tip of the
APClI nozzle.

8.1.2.4. Reassemble the APCI probe assembly as follows:

8.1.2.4.1. Unscrew and remove the APCI manifold from the APCI probe. Take
care not to damage the sample tube.

8.1.2.4.2. Gently screw the vaporizer casing back into the vaporizer flange.

8.1.2.4.3. Reinstall the heater coil and quartz insulator into the vaporizer casing.

8.1.2.4.4. Use a Phillips screw driver to reattach the electrical ground wire to the
vaporizer flange.

8.1.2.4.5. Reinstall the heater retainer and secure it with the socket-head screw.

8.1.2.4.6. Reinstall the APCI probe (minus the APCI manifold) into the APCI
flange.

8.1.2.4.7. Carefully slide the sample tube through the APCI flange, through the
sheath gas tube and out the APCI nozzle.

8.1.2.4.8. Screw the APCI manifold onto the APCI probe.

8.1.2.4.9. Rotate the APCI probe until the half-moon of the heater retainer is
oriented away from the tip of the corona discharge needle (when the
corona discharge needle is installed). Tighten the Probe retainer bolt to
secure the APCI probe to the APCI flange.

8.1.2.4.10. Move the ground wire away from the vaporizer casing.

8.1.2.4.11. Reinstall the corona discharge needle by inserting it into the socket in

the corona discharge needle assembly.
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8.1.3.

ESI Probe Maintenance

The fused-silica sample tube is replaced when it is broken or when it is blocked and
the blockage cannot be removed. The sample tube can be replaced without
disassembling the ESI probe. However, in order to clean the interior surfaces or
replace the electrospray needle or needle seal, the ESI probe is disassembled.

PROBE
RETAINER BOLT

GROUNDED
FITTING ES|

FLANGE

3.737-IN, O-RING

//
/ ~ GROUNDED 1.862-IN. O-RING
/ EITTING — '
| HOLDER
|| _ 1.739-IN. O-RING
)
b NOZZLE
SAMPLE T
TUBE
SAMPLE INLET — ESI
FITTING [~ 1% NEEDLE
GROUND SHIELD MANIFOLD
ES| PROBE MANIFOLD
SLEEVE

Figure 3. Cross sectional view of the ESI probe assembly.

8.1.3.1. Disassemble the ESI probe assembly as follows:

8.1.3.1.1. Remove the transfer line fitting from the grounded fitting holder on the
ESI flange. See Figure 3.

8.1.3.1.2. Unscrew the sample inlet fitting and remove the sample tube and sample
inlet fitting from the ESI probe.

8.1.3.1.3. Loosen the probe retainer bolt that holds the ESI probe in the ESI flange
and remove the ESI probe. Pull the ESI probe toward the inside (spray
chamber side) of the ESI flange.

SOP/CECEM/EQP/06/01 Page 9 of 33
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Figure 4. Exploded view of the ESI probe.

8.1.3.2. Replace the ESI needle if it is damaged. Replace the needle seal if the sheath
liquid is leaking at the needle seal-needle interface. Replace the ESI needle as
follows (see Figure 4):
8.1.3.2.1. Remove the ESI needle nozzle from the ESI manifold. Use a 5/16-in
wrench to loosen the nozzle.
8.1.3.2.2. Remove the ESI needle and needle seal from the ESI manifold. If
necessary, after removing the needle, use the needle to push the needle
seal out of the ESI manifold.
8.1.3.2.3.  Replace the needle seal and/or the ESI needle.
8.1.3.2.4. If necessary, clean the bore of the ESI nozzle with an appropriate
solvent (this depends on the solubility of the chemical deposits). Rinse
the nozzle with methanol and dry the nozzle with nitrogen gas.
8.1.3.2.5. Reassemble the ESI probe by following the instructions in Section
8.1.5.5.

8.1.3.3. Clean the manifold sleeve and ground shield as follows:
Remove the ground shield and clean and dry the manifold sleeve and if sample
liquid has leaked into the manifold sleeve-ground shield interface.
8.1.3.3.1. Remove the high voltage connector, star washer and spring using a 1/2 —
in. wrench.
8.1.3.3.2.  Pull the ground shield away from the ESI manifold and manifold sleeve.
8.1.3.3.3. Rinse the LC leakage away from the manifold sleeve and ground shield

with water and then rinse with methanol.
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8.1.3.3.4. Use a Kimwipe or lint-free tissue paper to remove the excess methanol

from the manifold sleeve and ground shield.

8.1.3.3.5. Dry the manifold sleeve and ground shield with nitrogen gas.

8.1.3.3.6. Reinstall the ground shield over the ESI manifold and manifold sleeve.

Ensure that the 1.739-in. ID O-ring is properly positioned between the

manifold sleeve and ground shield.

8.1.3.3.7. Replace and tighten the high voltage connector (along with the star

washer and spring) with a 72-in. wrench.

8.1.3.4. Reassemble the ESI probe as follows:
8.1.3.4.1.  Check the following:

8.1.3.4.1.1.

8.1.3.4.1.2.

8.1.3.4.1.3.

The O-rings (0.239-in. ID and 1.257-in. ID) on the ESI nozzle
are in good conditions. Replace the O-rings if necessary.

The 0.239-in. ID O-ring is placed past the threads on the ESI
nozzle.

The 1.257-in. ID is properly seated on the ESI nozzle.

8.1.3.4.2. Reinstall the ESI nozzle, needle and needle seal as follows.

8.1.3.4.2.1.

8.1.3.4.2.2.
8.1.3.4.2.3.

8.1.3.4.24.

Insert the entrance end of the ESI needle into the needle seal.
See Figure 5.4 for the proper orientation of the needle seal.

Seat the ESI needle and needle seal in the ESI manifold.

Thread the ESI nozzle over the needle and into the ESI
manifold.

Gently tighten the ESI nozzle until it is a little more than finger-
tight.

8.1.3.4.3. To install a new sample tube, proceed as follows.

8.1.3.4.3.1.

8.1.3.4.3.2.

8.1.3.4.3.3.

Cut (using a fused-silica cutting tool) a 30 cm (12 in.) piece of
fused-silica sample tubing (0.190 mm ID x 0.400 mm OD).
Insert the fused-silica tube through the exit end of the ESI spray
needle and into the ESI probe. See Figure 5.

Push the fused-silica sample tube through the ESI probe until it
exits the sample inlet and only about 1.5 inch is left protruding

from the exit end of the spray needle.
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8.1.3.4.3.4. Slide a 0.008 inch ID Kel-F® ferrule, narrow end first, onto the
fused-silica sample tube.

8.1.3.4.3.5. Slide a (brown) sample inlet fitting (Upchurch 1/16 inch
Fingertight fitting, P/N 00101-18915) onto the fused-silica
sample tube and into the sample inlet. Tighten the fitting
slightly, but not completely.

8.1.3.4.3.6. Slide a (red) Fingertight fitting (1/16 inch Upchurch Fingertight
fitting) and a 0.008 inch ID Kel-F® ferrule , wide end first, onto
the free end of the fused silica sample tube.

8.1.3.4.3.7. Connect the fused silica sample tube and ferrule to the ground
fitting holder by tightening the Fingertight fitting. Ensure the
fused-silica sample tube is held tightly in the grounded fitting
by gently pulling the fused-silica sample tube.

8.1.3.4.3.8. From the ESI sample inlet, carefully pull the fused silica sample
tube backwards until it is recessed inside the spray needle by
approximately 1 mm.

8.1.3.4.3.9. Tighten the (brown) sample inlet fitting to securely hold the
fused-silica sample tube in place.

8.1.3.4.3.10. Place a 1/16-in Upchurch Fingertight fitting and a 0.008-in. ID,
Kel-F ferrule on the free end of the sample tube.

8.1.3.4.3.11. Connect the free end of the sample tube to the transfer line
fitting.

8.1.3.4.3.12. Proceed to Section 8.1.5.5.5. Reinstalling the ESI probe.

8.1.3.4.4. To install the old sample tube and the ESI nozzle, needle and needle
seal, proceed as follows:

8.1.3.4.4.1. Insert the old sample tube (with a 0.008-in. ID, Kel-F ferrule
and sample inlet fitting on it) through the sample inlet and out
the exit end of the ESI probe.

8.1.3.4.4.2. Insert the entrance end of the ESI needle into the needle seal.
See Figure 6 for the proper orientation of the needle seal.

8.1.3.4.4.3. Insert the ESI needle and needle seal over the sample tube. Seat
the ESI needle and needle seal in the ESI manifold.
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8.1.3.4.4.4. Ensure that the sample tube protrudes at least 1 in. past the end
of the needle. Tighten the sample inlet fitting slightly, but not
completely.

8.1.3.4.4.5. Thread the ESI nozzle over the sample tube and ESI needle and
into the ESI manifold.

8.1.3.4.4.6. Gently tighten the ESI nozzle until it is a little more than finger-
tight.

8.1.3.4.4.7. Pull the sample tube backwards until it is 1mm inside the exit
end of the ESI needle. See Figure 6.

8.1.3.4.4.8. Tighten the sample inlet fitting securely to hold the sample tube

in place.

p ”5 FUSED-SILICA
I CAPILLARY
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o = l

Er— —uﬂ_m \ INSERT SAMDP UBE
|J"| ES
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FROM THIS DIRECTION
-
ESI PROBE
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INLET / |

ESI [L
MANIFOL

SAMPLE TUBE

Figure 6. Installing the ESI fused-silica sample tube.

8.2. API Stack Maintenance
Replace the heated capillary if the capillary is totally blocked or if the heater fails. Clean
the spray shield, heated capillary, tube lens, skimmer and other components on a periodic
basis. The API stack is disassembled in order to clean the components.
8.2.1. Remove the API stack as follows:
8.2.1.1. Make sure that the system is completely shut down and the LCQ power cord s
unplugged.
8.2.1.2. Loosen the two flange retainer bolts that secure the API flange to the spray
shield.
8.2.1.3. Pull back the API probe assembly from the spray shield.
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8.2.1.4. Disconnect the waste line from the spray shield.

8.2.1.5. Disconnect the API stack electrical cable from the spray shield by turning the

tab on the end of the cable counterclockwise and then pulling the cable free.

8.2.1.6. Grasp the spray shield with both hands and carefully pull it and the stack free

from the vacuum manifold. Place the stack on a clean surface with the spray

shield down. Allow the API stack to cool to ambient temperature before you

TUBE LENS
TUBE LENS AND
SKIMMER MOUNT SKIMMER SKIMMER LEAD
TUBE LENS
LEAD HEATED

CAPILLARY

' E ‘t =

6
g)ar\?n[ql\(j; K SPRAY HEATED CAPILLARY
HEATED SHIELD CABLE CONNECTOR
CAPILLARY CONNECTOR
MOUNT RETAINER

Figure 7. API stack components

8.2.2. Disassemble the API stack as follows:

8.2.2.1. Wear a clean, lint-free, nylon or cotton gloves when handling the API stack

components. Refer to Figure 7 and Figure 8 for the location of the various API

stack components.

8.2.2.2. Disconnect the skimmer electrical lead from the lead pin on the skimmer.
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8.2.2.3. Disconnect the tube lens electrical lead from the lead pin on the tube lens.

8.2.2.4. Pull the tube lens and skimmer mount free from the heated capillary mount.

8.2.2.5. Detach the skimmer from the tube lens and skimmer mount by pushing on its
lead pin.

8.2.2.6. Detach the tube lens from the tube lens and skimmer mount by pushing the tube
lens away from the skimmer mount.

8.2.2.7. Unscrew the locking ring on the heated capillary cable. Disconnect the heated
capillary cable from the connector on the connector retainer.

8.2.2.8. Loosen the heated capillary mount from the spray shield by turning it
counterclockwise, Use a wrench, if necessary.

8.2.2.9. Remove the heated capillary, heated capillary sleeve, heated capillary mount, O-
ring (0.299-in. ID) off the end of the heated capillary.

8.2.2.10. Pull the heated capillary out of the heated capillary mount.
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Figure 8. Exploded view of the API stack.
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8.2.3. Clean the API stack components as follows:

8.23.1.

823.2.

8.2.3.3.

8.2.3.4.

Clean the inner bore of the tube lens with LC-MS grade methanol a cotton-
tipped applicator.

Clean the entrance and exit ends of the skimmer using methanol and a cotton-
tipped applicator or Kimwipe.

Clean the entrance end, exit end and exterior of the heated capillary using
methanol and a Kimwipe. Flush the bore of the heated capillary with methanol
and allow it to dry.

Clean the spray shield by wiping the inside and outside with methanol and a

Kimwipe.

8.2.4. Reassemble the API stack as follows:

8.2.4.1.

8.2.4.2.

8.2.4.3.

8.2.4.4.

8.2.4.5.

8.2.4.6.

Wipe the heated capillary and the O-ring (0.299-in. ID) with a lint-free tissue.
Ensure that the heated capillary sleeve and the O-ring (0.299-in. ID) are in good
condition. Replace them if necessary.

Seat the heated capillary mount bushing in the end of the heated capillary
mount.

Insert the heated capillary through the heated capillary mount and heated
capillary mount bushing.

Place the O-ring (0.299-in. ID) and the heated capillary sleeve over the end of
the heated capillary so that the heated capillary protrudes by approximately 1 in.
past the end of the heated capillary sleeve.

Insert the heated capillary, heated capillary mount, heated capillary mount
bushing, O-ring and heated capillary sleeve through the connector retainer and
into the spray shield until the heated capillary and heated capillary sleeve
protrude from the atmospheric pressure side of the spray shield. Make sure that
the heated capillary cable is on the same side as the connector on the connector
retainer. See Figure 7.

Screw and hand-tighten the heated capillary mount into the spray shield. (The
heated capillary mount bushing should seat in the end of the heated capillary
mount and apply a force that compresses the 0.299-in. ID O-ring against the
heated capillary sleeve. See Figure 9.
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8.2.4.7. Reconnect the heated capillary cable to the connector that is held by the
connector retainer. Turn the locking ring on the cable clockwise to lock the
cable. See Figure 7.

8.2.4.8. Insert the tube lens and skimmer mount over the heated capillary until it seats in
the heated capillary mount. The tube lens and skimmer mount should be aligned
such that the heated capillary cable comes out of the opening side of the tube
lens and skimmer mount.

8.2.4.9. Align the guide pin on the tube lens with the guide pin hole on the tube lens and
skimmer mount. Reinstall the tube lens by inserting it into the tube lens and
skimmer mount.

8.2.4.10. Align the lead pin on the skimmer with the lead pin hole on the tube lens and
skimmer mount. Reinstall the skimmer by inserting t into the tube lens and
skimmer mount.

8.2.4.11. Reconnect the tube lens lead to the lead pin on the tube lens. Use needlenose
pliers if necessary.

8.2.4.12. Reconnect the skimmer lead to the lead pin on the skimmer. Use needlenose
pliers if necessary.

8.2.4.13. Push the heated capillary from the atmospheric pressure side of the spray shield
until the opposite end of the heated capillary adjoins with the tube lens and
skimmer mount.

8.2.4.14. Inspect the API stack. Ensure that the O-ring (3.85-in. ID) is in good condition
and properly seated on the spray shield. Ensure that all components fit together
tightly.

8.2.4.15. Reinstall the API stack.
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Figure 9. Cross sectional view of the entrance end of the API stack.

8.2.5. Reinstall the API stack as follows:

8.2.5.1.

8.2.5.2.

8.2.5.3.

8.2.54.

8.2.5.5.

8.2.5.6.

Using a screwdriver, loosen the two screws that secure the lid to the capillary-
skimmer region of the vacuum manifold. Remove the lid.

Align the API stack with the opening in the front of the vacuum manifold. Turn
the API stack until the guide pin on the spray shield is aligned with the guide
pin hole in the vacuum manifold.

Insert the API stack carefully into the opening in the vacuum manifold until it
seats in the vacuum manifold. As the API stack is inserted, make sure that the
tube lens and skimmer mount inserts into the opening to the first octapole
region of the vacuum manifold.

Reinstall the lid to the capillary-skimmer region of the vacuum manifold. Using
a screwdriver, tighten the two screws that secure the lid to the vacuum
manifold.

Reconnect the API stack cable to the connector on the spray shield. Turn the tab
on the end of the cable clockwise (away from you) to secure the cable.

Reconnect the waste line to the spray shield.
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8.3. Cleaning the ion optics and mass analyzer
8.3.1. Remove the top cover of the MS detector as follows:

8.3.1.1. Shut down the system.

8.3.1.2. Disconnect any tubing between the syringe pump and the API source.

8.3.1.3. Open the left and right front doors of the MS detector by loosening the 4 in.
Allen screw on the right front door with an Allen wrench.

8.3.1.4. Loosen the four fasteners that hold the top cover to the MS detector chassis.
The fasteners are located at the upper right and left corners of the chassis.

8.3.1.5. Slide the top cover back by about 1.25 cm (0.5 in.).

8.3.1.6. With one hand under the center of the top cover, lift the top cover up and away

from the MS detector.

ELECTRON MULTIPLIER
HIGH VOLTAGE CABLE

DAMPING

GAS LINE ELECTROMETER

LENSES CABLE

ENDCAP ELECTRODE CABLES
OCTAPOLES CABLE

Figure 10. Electrical connections and damping gas line connection to the top cover plate of the

vacuum manifold.

8.3.2.  Remove the top cover plate of the vacuum manifold as follows (refer to Figure 10):
8.3.2.1. Disconnect (at ANAL. AUX 1 IN) the octapoles cable that comes from the
Analyzer Auxillary PCB.
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8.3.2.2. Disconnect (at ANALYZER) the lenses cable that comes from the System
Control PCB.

8.3.2.3. Disconnect (at ANAL.AUX 2 IN and ANAL. AUX 3 IN) the two endcap
electrode cables that come from the Analyzer Auxiliary PCB.

8.3.2.4. Disconnect (at ACQU/DSP) the electrometer cable. (If necessary, use a small
screw driver to loosen the screws that secure the cable.)

8.3.2.5. Disconnect (at MULT) the electron multiplier high voltage cable that comes
from the electron multiplier power supply.

8.3.2.6. Use a 7/6-in. open-end wrench to disconnect the helium damping gas line from
the fitting.

8.3.2.7. Carefully lift the top cover plate straight up by its two handles. Take care not to
damage the components on the underside of the cover plate. Place the cover
plate upside down (supported on its handles) on a flat surface.

8.3.2.8. Cover the opening in the top of the vacuum manifold with a large, lint-free

tissue.

FIRST OCTAPOLE
DAMPLII':JE GAS SECOND OCTAPOLE, | EADS (PINS 1 & 3)

LEADS (PINS 1&3)

INTEROCTAPOLE
LENS LEAD (PIN7)

ENTRANCE ENDCAP
EXIT ENDCAP ELECTRODE LEAD
ELECTRODE LEAD (PIN 5)
(PIN 4)

EXIT LENS LEAD
(PIN 2)

Figure 11. Mass analyzer and ion optics, showing electrical and damping gas line connections.
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8.3.3. Remove the ion optics and mass analyzer by following the procedure below. Refer

to Figure 11 and Figure 12 for the location of ion optics and mass analyzer. Refer to

Figure 13 and Figure 14 for the location of the ion optics and mass analyzer

components. Wear a clean, lint-free, nylon or cotton gloves handling the ion optics

and mass analyzer components.

SECOND THUMB

MASS OCTAPOLE BAFFLE

ANALYZER

o/ —
ST e

8-PIN FEED- ANALYZER
THROUGH MOUNT

OCTAPOLE
FIRST MOUNT

OCTAPOLE

Figure 12. Mass analyzer and ion optics, mounted to the baffle on the top cover plate of the

vacuum manifold.

8.3.3.1.

8.3.3.2.

8.3.3.3.

8.3.34.

8.3.3.5.

8.3.3.6.

Prepare a clean work area by covering the area with lint-free paper. Place each
part on the paper as you remove it.

Disconnect the two electrical leads to the first octapole. See Figure 11.

Hold the octapole mount with one hand; loosen and remove the two thumb
screws that hold the octapole mount to the baffle on the top cover plate of the
vacuum manifold. See Figure 12.

Remove the first octapole and octapole mount.

Disconnect the electrical lead to the interoctapole lens. Remove the
interoctapole lens. See Figure 11.

Disconnect the electrical leads to the second octapole and to the exit lens, exit
endcap electrode, and entrance endcap electrode of the mass analyzer. See

Figure 11.
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8.3.3.7.

8.3.3.8.

8.3.3.9.

Disconnect the damping gas line from the nipple on the exit endcap electrode
by pulling the line free from the nipple. See Figure 12.

Hold the mass analyzer with one hand;loosen the two thumb screws that hold
the analyzer mount to the baffle. See Figure 12.

With one hand holding the mass analyzer and the other hand holding the
analyzer mount, lift the mass analyzer, second octapole, and analyzer mount
out and away from the baffle on the top cover plate. Be careful not to touch
the electron multiplier with the mass analyzer. This could damage the

electropolished surface.

THUME SCREW H«gj—/)
P
AN
o o A
‘{\\\-t_\ '-.‘-,'-Vf*’/ .
N \
A | | OCTAPOLE
MOUNT
\ FIRST

OCTAPOLE

II
\ INTEROCTAPOLE LENS

. T BAFFLE ON

TOR COVER PLATE
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Figure 13. Exploded view of the ion optics.

8.3.4. Disassemble the ion optics and mass analyzer by following the procedure below.

Refer to Figure 13 and Figure 14 for the location of the ion optics and mass analyzer

components.

8.3.4.1. Remove the first octapole from the octapole mount.
8.3.4.2. Remove the second octapole from the analyzer mount.

8.3.4.3. Disassemble the mass analyzer as follows:
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8.3.4.3.1. Remove the exit lens by pulling the exit lens out of the exit lens sleeve.
Use the connector pin to pull the lens.

8.3.4.3.2. Remove the exit lens sleeve by squeezing the sleeve and pulling it out
of the recess in the exit endcap electrode.

8.3.4.3.3. Unscrew and remove the two nuts from the posts.

8.3.4.3.4. Remove the two spring washers from the posts.

8.3.4.3.5. Remove the exit endcap electrode from the posts.

8.3.4.3.6. Remove the two spacer rings and the ring electrode.

8.3.4.3.7. Remove the entrance endcap electrode from the posts.

8.3.4.3.8. Unscrew and remove the two posts from the analyzer mount.

ANALYZER

ENTRANCE ENDCAP
ELECTRODE

EXIT ENDCAP
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\
N
\
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)
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Figure 14. Exploded and assembled views of the mass analyzer.

8.3.5. Clean the ion optics and mass analyzer parts by following the procedure below.
Wear a clean, lint-free, nylon or cotton gloves to handle the parts. Clean each part in
turn. After cleaning, place each part on a clean, lint-free surface.

8.3.5.1. With a soft tooth brush or lint-free swab, scrub the ion optics or mass analyzer
part with a solution of detergent and water.

8.3.5.2. Rinse the part with tap water to remove the detergent.

8.3.5.3. Rinse the part with distilled water.




@

UNIVERSITAT DE BARCELONA

B

Facultat de Quimica

Departament de Quimica Analitica.

Standard Operating Procedure (SOP)

8.3.5.4. Place the part in a tall beaker and immerse it completely in MS-grade

methanol. Move the part up and down in the methanol for 15 s.

8.3.5.5. Remove the part from the methanol bath; then rinse it thoroughly with fresh

methanol.

8.3.5.6. Dry the part with a rapid stream of nitrogen gas.

8.3.5.7. Inspect each part for contamination and dust. If necessary, repeat the cleaning

procedure.

8.3.6. Reassemble the ion optics and mass analyzer. Refer to Figure 13 and Figure 14.

Wear a clean, lint-free, nylon or cotton gloves when handling components of the

mass analyzer.

8.3.6.1. Reassemble the mass analyzer as follows:

8.3.6.1.1.

8.3.6.1.2.

8.3.6.1.3.
8.3.6.1.4.

8.3.6.1.5.
8.3.6.1.6.

8.3.6.1.7.

Reinstall the two posts by screwing them by hand into the analyzer
mount. (Both ends are the same.)

Reinstall the entrance endcap electrode onto the posts. (The entrance
endcap electrode is the one without the damping gas nipple.)Ensure
that the electrode is oriented such that the convex surface faces away
from the analyzer mount. Also, the opening in which the pin on the end
of the electrical lead inserts should be close to the top cover plate when
the analyzer mount is installed on the top cover plate. See Figure 11.
Place a spacer ring into the groove in the entrance endcap electrode.
Reinstall the ring electrode onto the spacer ring so that the spacer ring
is held securely between the electrodes. The orientation of the ring
electrode is unimportant. (Both sides are the same.)

Reinstall the second spacer ring into the groove in the ring electrode.
Reinstall the exit endcap electrode (the one with the damping gas
nipple) on the posts such that the spacer ring is held in place between
the ring electrode and the exit endcap electrode. Make sure that the
electrode is oriented such that the convex surface faces the spacer ring.
Also, the damping gas nipple should point toward the top cover plate
when the analyzer mount is installed on the top cover plate.

Inspect the mass analyzer assembly. Ensure that all the parts are

aligned properly and that they all fit together snugly.
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8.3.6.1.8. Reinstall the two spring washers on the posts such that the convex
sideof the washer is toward the exit endcap electrode.
8.3.6.1.9. Reinstall the two nuts onto the posts and tighten the nuts by hand until
they are finger tight. Do not overtighten the nuts.
8.3.6.1.10. Squeeze the exit lens sleeve and insert it into the recess in the exit
endcap electrode. See Figure 14 for the proper orientation of the exit
lens sleeve.
8.3.6.1.11. Insert the exit lens into the exit lens sleeve such that the lead pin on the
exit lens points in the same direction as the 8-pin feedthrough when the
analyzer mount is installed on the top cover plate. See Figure 11. Make
sure that the exit lens lead pin does not contact the nut on the end of the
mass analyzer post.
8.3.6.2. Insert one of the octapoles into the octapole mount. (Both octaples are the
same.)
8.3.6.3. Insert the other octapole through the cylindrical end of the analyzer mount until
it seats in the entrance endcap electrode of the mass analyzer. Turn the octapole
until the lead pins are on the same side as the 4-pin feedthrough (when the

analyzer mount is mounted on the top cover plate).

8.3.7. Reinstall the ion optics and mass analyzer by following the procedure below. Wear a
clean, lint-free, nylon or cotton gloves when handling components of the mass
analyzer.

8.3.7.1. Insert the cylindrical end of the analyzer mount (with the mass analyzer and
second octapole attached) into the opening in the baffle on the top cover plate of
the vacuum manifold. Ensure that the open side of the analyzer mount is away
from the top cover plate. See Figure 12.

8.3.7.2. Secure the analyzer mount to the baffle with the two thumb screws.

8.3.7.3. Insert the interoctapoles lens, lead pin first, through the opening in the baffle.
Turn the interoctapole lens until the lead pin is on the same side as the §-pin
feedthrough. Ensure that the second octapole is held securely between the
endcap electrode and the interoctapole lens. Also, ensure that the lead pins on

the octapole are on the same side as the 4-pin feedthrough.
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8.3.74.

8.3.7.5.

8.3.7.6.

8.3.7.7.

8.3.7.8.

8.3.7.9.

Attach the first octapole and octapole mount to the baffle on the top cover plate
with the two thumb screws. Ensure that the interoctapole lens is held securely
between the two octapoles. Also ensure that the lead pins on the octapole are on
the same sise as the 4-pin feedthrough.

Inspect the ion optics. Ensure that all the parts are aligned properly and that they
all fit together snugly.

Reconnect the two electrical leads from pins 1 and 3 of the 4-pin feedthrough
(see Figure 11) to the first octapole.

Reconnect the electrical lead from pin 7 of the 8-pin feedthrough (see Figure 5-
10) to the interoctapole lens.

Reconnect the two electrical leads from pins 1 and 3 of the 4-pin feedthrough
(see Figure 11) to the second octapole.

Reconnect the electrical lead from pin 5 of the 8-pin feedthrough (see Figure 11)
to the entrance endcap electrode by inserting the pin on the end of the lead into

the socket in the electrode.

8.3.7.10. Reconnect the electrical lead from pin 4 of the 8-pin feedthrough (see Figure 11)

to the exit endcap electrode by inserting the pin on the end of the lead into the

socket in the electrode.

8.3.7.11. Reconnect the electrical lead from pin 2 of the 8-pin feedthrough (see Figure 11)

to the exit lens. Ensure that the exit lens lead pin does not contact the nut.

8.3.7.12. Reconnect the damping gas line to the nipple on the exit endcap electrode.

8.3.8. Clean the conversion dynode and electron multiplier of the ion detection system by

blowing them with clean, dry gas such as nitrogen.

8.3.9. Reinstall the top cover plate of the vacuum manifold as follows:

8.3.9.1.
8.3.9.2.

8.3.9.3.

Remove the tissue from the opening in the top of the vacuum manifold.

Check the O-ring that surrounds the opening for signs of wear, and replace it if
necessary. Make sure that the O-ring is seated properly.

Carefully lift the top cover plate up by its two handles and turn it over. Orient
the top cover plate such that the electron multiplier is over the conversion
dynode. Carefully insert the guide posts on the underside of the top cover plate
into the guide holes in the vacuum manifold. Slowly lower the cover plate onto

the opening in the vacuum manifold. Take care not to damage the components
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8.3.94.

8.3.9.5.

8.3.9.6.

8.3.9.7.

8.3.9.8.
8.3.9.9.

on the underside of the cover plate. Ensure that cover plate is seated properly on
the vacuum manifold.

Use a 7/16-in. open-end wrench to reconnect the helium damping gas line to the
fitting. See Figure 10.

Reconnect (at ANAL. AUX 1 IN) the octapoles cable that comes from the
Analyzer Auxiliary PCB.

Reconnect (at ANALYZER) the lenses cable that comes from the System
Control PCB.

Reconnect (at ANAL. AUX 2 IN and ANAL. AUX 3 IN) the two endcap
electrode cables that come from the Analyzer Auxiliary PCB.

Reconnect (at ACQU/DSP) the electrometer cable.

Reconnect (at MULT) the electron multiplier high voltage cable that comes

from the electron multiplier power supply.

8.3.10.  Reinstall the top cover of MS detector as follows:

8.3.10.1.
8.3.10.2.

8.3.10.3.

8.3.10.4.

8.3.10.5.
8.3.10.6.

8.4. Replacin

Open the left and right front doors of the MS detector.

With one hand under the center of the top cover, place the top cover over the
MS detector such that the front of the cover is about 1.25 cm (0.5 in.) behind
the front of the MS detector.

Slide the cover forward until it is flush with the front doors (when they are
closed).

Tighten by hand the four fasteners to secure the top cover to the chassis.
Close the left and right front doors of the MS detector.

Reconnect any tubing between the syringe pump and the API source to

accommodate your instrument configuration.

g the electron multiplier

The electron multiplier may need to be replaced when there is excessive noise in the mass

spectrum or whenever there is inability of the multiplier gain calibration procedure to

achieve a gain of 3 x 10 electrons per ion with an electron multiplier voltage less than or

equal to 2.5 kV. Replace the electron multiplier as follows:

8.4.1. Shut

down and vent the system.

8.4.2. Remove the top cover of the MS detector as described in Section 8.3.1.
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8.4.3.
8.4.4.

8.4.5.

8.4.6.

8.4.7.

8.4.8.

8.4.9.

Remove the top cover plate of the vacuum manifold as described in Section 8.3.2.
With an Allen wrench, remove the two socket-head screws that hold the electron
multiplier support to the top cover plate of the vacuum manifold. See Figure 15.

With one hand hold the high voltage tube and with the other hand hold the electron
multiplier support. Detach the high voltage tube from the high voltage feedthrough in
the top cover plate and remove the electron multiplier as a unit. (The anode remains
in the anode feedthough in the top cover plate.)

Remove the anode from the anode feedthrough by unscrewing it counterclockwise by
hand.

Install a new anode in the anode feedthrough in the top cover plate by screwing it
clockwise by hand.

With one hand holding the high voltage tube and the other hand holding the electron
multiplier support, install the electron multiplier on the top cover plate. Ensure that
the high voltage tube is properly inserted in the high voltage feedthrough and that the
screw holes in the electron multiplier support are aligned with the screw holes in the
top cover plate.

Reinstall the two socket-head screws that secure the electron multiplier support to the
top cover plate. Tighten the screws with an Allen wrench. (If you installed a new
electron multiplier in step 8.4.8, go to step 8.4.11. If you want to replace the cathode,

g0 on to the next step.)

—
HIGH VOLTAGE RING
SUPPORT PLATE
HIGH VOLTAGE TUBE SCREW

ELECTRON MULTIPLIER

SCREW SUPPORT

ANODE ol @
ANODE
FEEDTHROUGH
= - -

HIGH VOLTAGE
FEEDTHROUGH

TOP COVER PLATE
OF THE VACUUM MANIFOLD

Figure 15. Exploded view of the electron multiplier, showing the anode.
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ELECTRON MULTIPLIER
SHIELD

CATHODE
SPRING WASHER

HIGH VOLTAGE
RING

HIGH VOLTAGE
TUBE

SUPPORT PLATES

HIGH VOLTAGE
FEEDTHROUGH

TOP COVER PLATE

OF THE VACUUM MANIFOLD ELECTRON MULTIPLIER

SUPPORT

Figure 16. Exploded view of the electron multiplier, showing the cathode.

8.4.10. To replace the cathode, proceed as follows (see Figure 16):

8.4.10.1.

8.4.10.2.

8.4.10.3.

8.4.10.4.
8.4.10.5.

8.4.10.6.

Using a Phillips screwdriver, loosen (but do not remove) the two screws that
secure the support plates to the high voltage ring.

With one hand, hold the high voltage tube. With the other hand, hold the high
voltage ring. Detach the high voltage tube from the high voltage feedthrough
and remove the electron multiplier. Place it on a clean surface. (The electron
multiplier support and the support plates should remain attached to the top
cover plate.)

Turn the assembly over. Using a Phillips screwdriver, remove the two screws
that secure the electron multiplier shield to the high voltage ring.

Remove the electron multiplier shield and cathode from the high voltage ring.
Insert the new cathode (narrow end first) through the spring washer and then
through the high voltage ring.

Place the electron multiplier shield over the wide end of the cathode such that
the screw holes in the electron multiplier shield are aligned with the screw

holes in the high voltage ring.
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8.4.10.7.

8.4.10.8.

Hold the high voltage ring and electron multiplier shield together to depress
the spring washer. Secure the high voltage ring to the electron multiplier
shield by using the two Phillips-head screws. (The cathode should be held in
place between the high voltage ring and the electron multiplier shield.)

Insert the end of the high voltage tube in the electron multiplier feedthrough in
the top cover plate. Reattach the high voltage ring to the support plates by
inserting the two screws in the sides of the high voltage ring into the notches
in the two support plates. Tighten the two Phillips-head screws that secure the
high voltage ring to the two support plates.

8.4.11. Reinstall the top cover plate of the vacuum manifold over the opening in the vacuum

manifold as described in Section 8.3.9.

8.4.12. Reinstall the top cover of the MS detector as described in Section 8.3.10.

8.4.13. Start up the LCQ system as described in the instrument operating instructions.

8.4.14. Set the electron multiplier voltage to -800 V as follows:

8.4.14.1. From the Tune Plus window, choose Diagnostics > Diagnostics.

8.4.14.2. Select the Graphs tab.

8.4.14.3. In the Set Device Value option box, select Multiplier (V).

8.4.14.4. In the text box to the right of the Set Device Value option box, enter -800.

8.4.14.5. Click on the Set button to set the electron multiplier voltage to -800 V.

8.4.14.6. Click on the OK button to return to Tune Plus.

8.4.15. Calibrate the electron multiplier voltage as follows:

8.4.15.1. Allow the system to pump down for at least one hour before you turn on the
high voltages.

8.4.15.2. Set up for the infusion of the tuning solution into the MS detector as described
in the document INSTRUCCIONES PARA LA CALIBRACION Y TUNING
DEL ESPECTROMETRO DE MASAS LCQ (Finnigan) (PNT 0351000
APR/103).

8.4.15.3. From the Tune Plus window, choose Control > Calibrate to open the
Calibrate dialog box.

8.4.15.4. Click on the Semi-Automatic tab.

8.4.15.5. Select the Electron Multiplier Gain option. Click on the Start button to start

the multiplier gain procedure. Close the dialog box after the Electron

Multiplier Gain program is finished.
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5/16-IN. SOCKET
SCREW (4x)

CONVECTRON
GAUGE

TURBOMOLECULAR
PUMP RAILS

TURBOMOLECULAR PUMP

VACUUM HOSE
CLAMP

FORELINE UNION

POWER CABLE

Figure 17. Turbomolecuglar pump.

8.5. Replacing the oil reservoir in the turbomolecular pump

Replace the oil reservoir in the turbomolecular pump at least once a year. Replace the

turbomolecular pump if it fails to operate. Follow these steps to replace the oil reservoir in

the turbomolecular pump.

8.5.1. Remove the turbomolecular pump as follows:

8.5.1.1.
8.5.1.2.

8.5.1.3.
8.5.14.

8.5.1.5.
8.5.1.6.

Shut down and vent the system.

Open the left and right front doors of the MS detector by loosening the 1/4-in.
Allen screw on the right front door with an Allen wrench. (Disconnect any
sample tubes between the syringe pump and the API source before opening the
right front door.)

Remove the top cover of the MS detector as described in Section 8.3.1.

Loosen the red hose clamp that secures the vacuum hose to the turbomolecular
pump (See Figure 17). Disconnect the vacuum hose from the turbomolecular
pump. Remove the centering ring from the vacuum hose.

Disconnect the power cable from the turbomolecular pump.

Loosen the four 5/16-in. socket screws that secure the turbomolecular pump to

the vacuum manifold. The turbomolecular pump should drop onto the
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8.5.1.7.

8.5.1.8.

turbomolecular pump rails. If necessary, wiggle the turbomolecular pump to
break the seal.

Pull the turbomolecular pump out on the rails. If necessary, disconnect one or
more of the vacuum hoses at the foreline union by loosening the clamping rings
and then pulling the hoses free from the foreline union.

Remove the turbomolecular pump.

8.5.2. Change the turbomolecular pump oil reservoir as follows:

8.5.2.1.
8.5.2.2.

8.5.2.3.

8.5.2.4.
8.5.2.5.

8.5.2.6.

Turn the turbomolecular pump upside down on a work bench.

Unscrew (use a large screwdriver) the locking cap on the bottom of the
turbomolecular pump. Remove the locking cap and O-ring.

Using a pair of tweezers, remove the oil reservoir from the pump. Dispose of the
oil reservoir properly.

Place a new oil reservoir in the cavity in the bottom of the pump.

Check the condition of the Viton O-ring. If it has any nicks or breaks, replace it
with a new one.

Reinstall the O-ring and locking cap. Tighten the locking cap securely with a

large screwdriver.

8.5.3. Reinstall the turbomolecular pump as follows (see Figure 17):

8.5.3.1.

8.5.3.2.

8.5.3.3.

8.5.34.

8.5.3.5.

8.5.3.6.

Check the condition of the Viton O-rings around the two openings on the bottom
of the vacuum manifold. (Use a small flashlight to illuminate the O-rings.) If
they have any nicks or breaks, replace them with new ones (P/N 00107-11100).
Place the turbomolecular pump on the turbomolecular pump rails.

Slide the turbomolecular pump into position under the openings in the vacuum
manifold.

With a 5/16-in. ball driver or Allen wrench, carefully tighten the four socket
screws that hold the turbomolecular pump to the vacuum manifold. Do not
overtighten the screws.

Place the centering ring in the end of the vacuum hose. Reconnect the vacuum
hose (with centering ring in place) to the turbomolecular pump. Tighten the red
hose clamp (Edwards, KF20) that secures the vacuum hose to the
turbomolecular pump.

Reconnect the turbomolecular pump power cable.
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8.5.3.7. If necessary, reconnect the vacuum hoses to the foreline union. Tighten the
clamping rings to secure the vacuum hoses to the foreline union.

8.5.3.8. Reinstall the top cover of the MS detector by following the procedure in Section
8.3.10.

8.5.3.9. Close the left and right front doors of MS detector.

8.5.3.10. Reconnect any tubing between the syringe pump and the API source that you

disconnected earlier.

8.6. Replacing the oil in the rotary vane pump/forepump
Change the oil or refill the oil in the forepump every 3 months or if oil is already cloudy or
dark-colored. Shut down the MS system before removing the pump connections. To

change the oil, follow the instructions on the pump’s manufacturer’s manual.

8.7. Cleaning the Fan Filter
Clean the fan filter every four months. Clean the fan filter as follows:
8.7.1. Remove the fan filter by reaching behind the MS detector and pulling the fan filter
out to the right.
8.7.2.  Wash the fan filter in a solution of soap and water.
8.7.3. Rinse the fan filter with tap water.
8.7.4. Squeeze the water from the fan filter and allow it to air dry.
8.7.5. When the fan filter is completely dry, reinstall it on the rear of the MS detector [or
replace it with a new one.
8.8. Observations
In cases where scheduled maintenance is delayed, instrument use may be put on hold
only if its use is critical to the analysis and if instrument shows uncharacteristic behavior.
Moreover, a notice must be posted about the reason on the delayed maintenance and the

probable date for carrying out the maintenance.

9. BIBLIOGRAPHY
LCQ MS Detector Hardware Manual Revision C, April 1997.
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OBJECTIVE

This document provides a guide on how to verify the performance of the Ascentis” Express RP-
Amide column. The verification of column performance is carried out in order to assess whether the
specifications determined by the vendor are met when the column is first used in the laboratory.
Moreover, when the column is routinely used, its performance will decline hence it is important to
monitor its performance through time using the same verification procedure. When the column is
new, the test is performed using all of the HPLC instruments found in the laboratory in order to have

a reference for future verification.

SCOPE
This procedure is applicable to the verification of a new column as well as to routinely used column

whose performance needs to be verified.

DEFINITIONS
3.1.  Plate number(N) — a number indicative of column performance, calculated from the following
equation i Y
N= 5.545[ - J
Wh

where t, stands for the retention time and wy, for the peak width at half height

3.2.  USP Tailing factor (T;) — used to measure the degree of peak symmetry and is calculated

using the following equation
T. = WO.OS

B of

where W, s is the peak width at 5% height and f is the front half-width at 5% of the peak
height.

3.3.  Capacity factor or retention factor (k") — a measure of the time the sample component resides
in the stationary phase relative to the time it resides in the mobile phase; it expresses how
much longer a sample component is retarded by the stationary phase than it would take to

travel through the column with the velocity of the mobile phase. It is calculated as




Facultat de Quimica
@ Standard Operating Procedure (SOP)

UNIVERSITAT DE BARCELONA

@ Departament de Quimica Analitica.

SOP/CECEM/EQP/07/01 Page 3 of 5

where t, stands for the retention time and t, for the retention time of the unretained compound.

3.4. Selectivity (a) — the relative retention value calculated for two adjacent peaks. It is also called

the separation factor and is calculated as

4, RELATED PROCEDURES
Not applicable.

5. RESPONSIBILITIES
Any person who uses the column is responsible for verifying its performance and ensuring that the

column performance is monitored.

6. INSTRUCTIONS
Evaluate the column efficiency using the chromatographic test conditions and test compounds
indicated on the HPLC column performance result. Perform the test on a new column to verify its

performance. Repeat the test periodically to monitor the column performance.

6.1. Prepare a solution of the test compounds necessary for the column test. The test compounds
are: 20 ug/mL uracil, 30 pug/mL acetophenone, pg/mL 4-Cl-nitrobenzene and 2.40 mg/mL
toluene in 50:50 (v/v) acetonitrile:water. It is necessary that these 4 test compounds are
available. However, in case one of the test compounds (acetophenone or 4-Cl-nitrobenzene) is
not available, the test must still be performed with the 3 compounds comprising the test
solution.

6.1.1. 50:50 (v/v) acetonitrile.water solution. Measure 25 mL of HPLC-MS grade acetonitrile
and mix with 25 mL of HPLC-MS grade water.

6.1.2. 1 mg/mL uracil solution. Weigh 5 mg of uracil and dissolve in 5 mL of 50:50 (v/v)
acetonitrile:water solution.

6.1.3. 1 mg/mL acetophenone solution. Pipet SpL of acetophenone and mix with 5 mL of

50:50 (v/v) acetonitrile:water solution.
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6.14.

1mg/mL 4-Cl-nitrobenzene solution. Weigh 5 mg of 4-Cl-nitrobenzene and dissolve in

5 mL of 50:50 (v/v) acetonitrile:water solution.

10 mg/mL toluene solution. Pipet 58 uL of toluene and mix with 5 mL of 50:50 (v/v)

acetonitrile:water solution

Column test solution. Pipet 20 uL of 1 mg/mL uracil solution, 30 pL of 1 mg/mL of

acetophenone solution, 77 uL of 1 mg/mL 4-Cl-nitrobenzene solution, 240 uL of 10
mg/mL toluene solution and 367 uL of 50:50 (v/v) acetonitrile:water solution into a

glass vial and mix.

6.2. Prepare the HPLC instrument for analysis.

6.2.1.1.
6.2.1.2.

6.2.1.3.
6.2.14.
6.2.1.5.

Fill the respective mobile phase reservoirs with water and acetonitrile.
Turn on the HPLC modules and the computer connected to the HPLC instrument. In
the computer, create a file name for the column test. Create a method for performing
the column test. The chromatographic conditions are as follows.

Mobile phase: 50:50 acetonitrile:water

Flow rate: 0.5 mL/min

Injection volume. 1 yL

Acquisition time. 4 min

Temperature: 25°C
Purge the HPLC solvent lines.
Connect the HPLC column.

Place the vial of the test solution in the autosampler rack.

6.2.2. Equilibrate the column with the mobile phase for at least 15 minutes before injecting the test

compound.

6.2.3. Obtain the test chromatogram and determine the number of theoretical plates (N), USP

tailing factor (Ty), selectivity and capacity factor (k") for the toluene peak. The calculations

can be done manually or by the HPLC software.

6.2.4. Compare the results with the vendor’s test chromatogram specification. To assess whether

the column passed the performance test, the following must be checked:

6.2.4.1. the test compounds must appear in the chromatogram
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6.2.4.2. the retention times are not significantly different
6.2.4.3. the values for the number of plates, tailing factor, selectivity and capacity factor are
within the minimum specifications set by the vendor.
6.2.5. If the column is new, repeat the test using the other HPLC instrument found in the
laboratory.
6.2.6. Observations
6.2.6.1. If the determined N value for a new column is < 80% of the specified value,
determine first whether there is a possibility of instrumental problems and make the
necessary corrections. Repeat the test using the same conditions.
6.2.6.2. For already used columns, the results for the N value will be normally lower than
the previous determinations. If the N value decreases by 50% then the column may

be replaced.

7. BIBLIOGRAPHY
Dong. M. W. 2006. Modern HPLC for Practicing Scientists. John Wiley and Sons, Inc., New Jersey.
IUPAC. 1993. Nomenclature for chromatography. Pure & Appl. Chem., 65(4), 819-872.
Snyder, L.R., Kirkland, J.J. and Giajch, J.L. 1997. Practical HPLC Method Development. 2™ Edition.
John Wiley & Sons, Inc., New York.
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COLUMN VERIFICATION LOGBOOK (ASCENTIS EXPRESS RP-AMIDE)

DATE

NAME

VERIFICATION RESULTS

Plates (N)

Tailing Factor (Ty) | Capacity factor (k")

Selectivity (@) | COMMENTS
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)SUPELCO

Analytical

" 585 North Harrison Road

Bellefonte, PA 16823-0048 USA
Telephone 800-247-6628 * 814-359-3441
Fax 800-447-3044 « 814-359-3044

email; supslco @sial.com

sigma-aldrich.com/supelco

SERIAL NO.: -

GN1421.
COLUMN: Ascentis Express RP-Amide 10cm x 2.1mm
PART NO.: 53913-U

FACKING LOT NO.:

TEST CONDITIONS:
MOBILE PHASE

S0B0bE

oEon

50/50 ACETONITRILE/WATER

PRESSURE 280 BAR
FLOW . 0.5 mL/min
LINEAR VELOCITY = 0,488 cm/sec
TEMPERATURE = AMBIENT
PERFORMANCE RESULTS FOR TOLUENE . (K =3.,92)
PARAMETER SPECIFICATIDN COLUMN GN1421
THEORETICAL PLATES MIN. 15080 18424
 USP TAILING FACTOR MAX: 1.25 1.01
SELECTIVITY RANGE: 1.15 - 1.35 1.21
3
; . v
@ ) .
] QC-‘ Sample:
; Uracil (20 pg/mi}

Acetophenone (30 pg/mi)
4-Cl-Nitrobenzene (77 pg/ml)
Toluene (2.40 mg/ml)
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1.

OBJECTIVE

This document describes the procedure for the verification of the performance of an LC-MS system

through an in-house method. Performance verification is necessary in order to ensure the proper

functioning of the LC-MS system. The verification involves the determination of the quality

parameters for an LC-MS/MS analysis of naphthylacetics. The acceptability of the results is assessed

by the defined acceptance criteria.

SCOPE

This procedure was established for the performance verification of an LC system coupled to the LCQ

MS using the LC-MS/MS analysis of naphthylacetics (1-naphthylacetamide, 1-naphthoxyacetic acid

and 2-naphthoxyacetic acid) in the selected reaction monitoring mode (SRM). The quality parameters

that are determined are as follows: limit of detection, limit of quantification, linearity and range and

precision.

DEFINITIONS

These definitions are in accordance with the ICH Harmonized Tripartite Guideline for the Validation

of Analytical Procedures (2005).

3.1. Precision — expresses the closeness of agreement (degree of scatter) between a series of

measurements obtained from multiple sampling of the same homogeneous sample

under the prescribed conditions. Precision may be considered at three levels:

repeatability, intermediate precision and reproducibility.

3.2. Limit of detection (LOD) — the lowest amount of analyte in a sample which can be detected but

not necessarily quantitated as an exact value.

3.3. Limit of quantitation (LOQ) — the lowest amount of analyte in a sample which can be

quantitatively determined with suitable precision and accuracy.

3.4. Linearity — the ability (within a given range) to obtain test results which are directly proportional

to the concentration (amount) of analyte in the sample.
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3.5. Range — the interval between the upper and lower concentration (amounts) of analyte in the
sample (including these concentrations) for which it has been demonstrated that the

analytical procedure has a suitable level of precision, accuracy and linearity.

4. RELATED PROCEDURES
Not applicable.

5. RESPONSIBILITIES

The analyst must be familiar with the operation of the LC-MS instrument when carrying out this task.

6. METHOD SUMMARY
The compounds are separated via the RP-amide column and identified and quantified using
electrospray ionization mass spectrometry. The LCQ MS detector is operated in the positive mode for
I-naphthylacetamide determination and in negative mode for naphthoxyacetic acid determination.
The Xcalibur data system is used to control the data acquisition and to store and manipulate the mass
spectral data. These compounds are identified and quantitated in the selected reaction monitoring

mode (SRM) using the quantification and confirmation ions presented in Table 1.

Table 1. Mass spectral Quantification and confirmation ions.

Analyte Quantitation ion m/Z Confirmation ion /m/z
1-naphthylacetamide 141 169
1-naphthoxyacetic acid 143 157
2-naphthoxyacetic acid 143 157

When using the Dionex HPLC system, instrument control is via the Chromeleon software, whereas,

the Waters Alliance LC is controlled manually.
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7. EQUIPMENT AND SUPPLIES

Dionex HPLC system or Waters Alliance liquid chromatograph

Finnigan LCQ MS detector with Xcalibur data system software

Column: Ascentis” Express RP-Amide, 10cm x 2.1 mm, 2.7 pm (Supelco)
Autosampler clear glass vials with screw cap, 1.8 mL, 12 x 32 mm (Thermo)
Analytical balance (Mettler Toledo or equivalent)

Pipettor (Socorex)

Spatula

8. REAGENTS AND STANDARDS
8.1.1. Reagents

e Methanol, LC-MS grade (Fluka or equivalent)
e Water, LC-MS grade (Fluka or equivalent)

e (lacial acetic acid, analytical grade (Merck or equivalent)

8.1.2. Standards

e l-naphthylacetamide PESTANAL®, 99% purity (Sigma-Aldrich)
e l-naphthoxyacetic acid, 98%purity (Aldrich)
e 2-naphthoxyacetic acid PESTANAL®, 98% purity (Sigma-Aldrich)

8.1.3. Preparation of mobile phase and standard solutions

8.1.3.1. 2mM acetic acid solution. Add 115 pL of acetic acid to 1000 mL water and mix.

8.1.3.2.

8.1.3.3.

1,000 ppm stock solution. Prepare a 1,000 ppm stock solution of each analyte. Weigh

5 mg of the solid standard and dissolve in 5 mL methanol. Weigh the solution. The

concentration of the stock solution is calculated as follows:

s
concentraton (mg/Kg) = mass of standard(mg) * purity

mass of solution (Kg)

and mix with 995 uL of methanol.

5 ppm 1-NAD standard solution. Pipet 5 uL of 1,000 ppm stock solution of 1-NAD
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8.1.3.4.

8.1.3.5.

8.1.3.6.

8.1.3.7.

8.1.3.8.

8.1.3.9.

8.1.3.10.

8.1.3.11.

5 ppm 1-NOA standard solution. Pipet 5 puL of 1,000 ppm stock solution of 1-NOA
and mix with 995 pL of methanol.

5 ppm 2-NOA standard solution. Pipet 5 pL of 1,000 ppm stock solution of 2-NOA
and mix with 995 uL of methanol.

500 ppb 1-NAD standard solution. Pipet 100 uL of 5 ppm solution of 1-NAD and
mix with 900 pL of methanol.

500 ppb 1-NOA standard solution. Pipet 100 uL of 5 ppm solution of 1-NOA and
mix with 900 pL of methanol.

500 ppb 2-NOA standard solution. Pipet 100 uL of 5 ppm solution of 2-NOA and
mix with 900 pL of methanol.

10 ppm intermediate standard solution. Pipet 30 uL each of the analyte stock

solution and mix with 3.910 mL of methanol. Weigh the aliquot and the solution.

200 ppb intermediate standard solution. Pipet 40 pL of the 10 ppm standard
solution and mix with 1.960 mL methanol. Weigh the aliquot and the solution.

Working standard solutions. Prepare the working standard solutions to be used for
linearity and LOD determinations as outlined in Table 2. A standard is prepared by
taking an aliquot of the intermediate standard solution into a glass vial and adding
with methanol. The weights of the aliquot and the resulting solution are recorded

and used for the calculation of the concentration.
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Table 2. Preparation of the working standard solutions.

From 10 ppm intermediate standard solution From 200 ppb intermediate standard solution
Concentration, | Volume of 10 ppm Volume of | Concentration, | Volume of 200 Volume of

ppb solution, pLL methanol, pL ppb ppb solution, uL. | methanol, pL
100 10 990 50 250 750

200 20 980 40 200 800

400 40 960 25 125 875

500 50 950 10 50 950

600 60 940 5 25 975

800 80 920 2.5 12.5 987.5
1,000 100 900

9. LIQUID CHROMATOGRAPH/MASSSPECTROMETER PREPARATION
9.1. Liquid chromatograph conditions

The HPLC conditions are as follows:

Column: Ascentis Express RP-Amide, 10 cm x 2.1 mm, 2.7um, Supelco
Mobile Phase: 2 mM acetic Acid: Methanol

Flow rate: 0.300 mL/min

Column Temperature: 50°C

Injection volume: 5 pL

Table 3. Gradient elution program.

Time, min %Methanol %Acetic acid
0 30 70
2 30 70
4 45 55
5 45 55
8.4 70 30
11.8 70 30
12.6 30 70
16.6 30 70

9.2. Mass spectrometer conditions

The mass spectrometer detection parameters are shown in Table 4. The ESI positive mode is run

separately from the ESI negative mode.
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Table 4. MS detection parameters.

Parameters 1-Naphthylacetamide Naphthoxyacetic acid
ESI mode positive negative
ESI Source parameters
Sheath gas (arb) 70 53
Auxiliary gas (arb) 40 48
Spray voltage (kV) 4 4
Capillary Temperature (°C) 250 250
Capillary voltage (V) 9 -17
Tube lens offset (V) -15 15
Segments 1 1
Scan events 1 1
Mass range Normal Normal
Scan mode MS/MS MS/MS
Precursor ion m/2 186.1 201.1
Isolation width 1.5 1.5
Normalized collision energy (%NCE) 25 29
Activation Q 0.40 0.40
Activation time (msec) 0.30 0.30

10. ANALYTE IDENTIFICATION
Prior to the analysis, the elution order of the analytes must be determined and/or verified. This is
carried out by injecting a standard solution (500 ppb) containing only the analyte and determining

the retention time. The MS/MS spectrum is also acquired.

11. PROCEDURE
11.1. Tuning the MS
Prior to analysis, the mass spectrometer must be tuned to maximize the sensitivity of the
instrument. Tuning involves the direct infusion of 5ppm of 1-NAD and 5 ppm of 1-NOA via
the syringe pump at a flow rate of 300uL/min and using a 50/50 methanol:2mM acetic acid
mobile phase. The scan parameters used were as follows: Scan mode: MS; Scan type. Full; MS’
power: 1; Number of Microscans. 3; Maximum inject time: 100, /nput Method: From/To;
Source: Offt,; Scan Fragmentation. From Mass 50 to 300. The automatic tuning is done via the

Tune program of the instrument.
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11.2.  Determination of quality parameters

11.2.1.

11.2.2.

11.2.3.

Instrument limit of detection (LOD) and limit of quantification (LOQ)

The limit of detection is determined by injecting standard solutions of decreasing
concentrations. For this purpose, the standard solution used ranges from 2.5 ppb to 100 ppb.
After injection, the chromatogram is inspected. The LOD is the concentration of the analyte
giving a signal 3 times more than the noise. The LOD is reported as the amount (ng) of
analyte injected in the chromatographic run and is derived as follows:

LOD = concentration (ng/ pL) * injection volume (puL)

The LOQ is reported as the amount (ng) of analyte injected that gives a signal 10 times more
than the noise. It is estimated from the LOD data using the expression

LOQ=33*LOD

Linearity

The linearity is determined over the range that is appropriate to the lowest and the highest
nominal concentration permissible in the instrument. The lowest concentration is defined
such that is similar to the determined LOQ. Determinations at 5 or more concentrations must
be made. Concentrations ranging from 25 ppb to 1ppm are typically used. A calibration plot
(peak area vs. concentration) is constructed and the equation of the calibration line and the
correlation coefficient (r) must be reported and the calibration plot is submitted. The
linearity of the plot is evaluated in terms of the correlation coefficient (r). A linear plot must

have anr>0.99.

Precision (Repeatability)
The repeatability is determined by performing 6 repeated injections of a standard (near the
midrange of the calibration curve). The mean, the standard deviation and %RSD are
calculated and the number of determinations is reported. The %RSD is used to evaluate
the precision (repeatability) of the method. The acceptability of the %RSD is assessed
based on the reproducibility CV (%RSDg) that can be derived using the Horwitz equation

which is expressed as
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%RSDR _ 2(1 —0.51log C)
where C is the mass fraction expressed as a power (exponent) of 10.
The repeatability (%RSDr) acceptability is proposed to be the Horwitz value for %RSDy
x 0.67.

11.3.  Peak Area integration
The Xcalibur data system is used for the integration of the peak area. The automatic peak area
integration can be used. However, if during the review of the chromatogram, the analyst
notices improper integration by the data system, the peaks can be reintegrated manually.
Smoothing actions can be applied in the chromatogram in order to minimize the influence of

noise. However, use the minimum points for smoothing.
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